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About this guide

 

This book describes configuring a network using S/DMS Network Manager 
Release 6 software.

 

Who should read this book

 

This book is intended for people responsible for configuring networks (admin 
access class).

 

S/DMS Network Manager documentation packaging

 

The documentation for S/DMS Network Manager is composed of one volume. 
The volume contains nine individual books:

•

 

Introduction

 

 (323-4001-102) introduces the features and user interface of 
S/DMS Network Manager.

•

 

Installation and Administration

 

 (323-4001-202) provides installation and 
administration information for S/DMS Network Manager. Also, this book 
provides information on configuring and bootstraping an operations 
controller (OPC), setting up serial ports for external device access, and 
customizing the S/DMS Network Manager user environment.

•

 

Connectivity

 

 (323-4001-053) provides information on logging in and out 
of S/DMS Network Manager, controllers (OPC and TL1 MOA), network 
element user interfaces, and external devices.

•

 

Configuration

 

 (323-4001-054) describes the Graphical Network Editor 
(GNE) tool of S/DMS Network Manager. The GNE is used to configure a 
network.

•

 

Fault Management

 

 (323-4001-055) describes the Graphical Network 
Browser (GNB) tool of S/DMS Network Manager. The GNB is used for 
network surveillance.

•

 

Performance Management

 

 (323-4001-056) describes centralized 
performance monitoring for the network elements monitored by S/DMS 
Network Manager.

•

 

Connection Management

 

 (323-4001-057) describes viewing, 
provisioning, and editing connections on ring and linear systems.
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•

 

Inventory Management

 

 (323-4001-058) describes taking an inventory of 
remote network elements monitored by S/DMS Network Manager.

•

 

Software Management

 

 (323-4001-059) describes controller and network 
element centralized software management.

 

Systems supported in this book

 

This book describes the operation of S/DMS Network Manager with 
S/DMS TransportNode, S/DMS AccessNode, Cornerstone Voice, SONET 
Radio 4/40, and TL1 MOA systems. The basic operation of S/DMS Network 
Manager is the same for each system. However, the availability of some 
features depends on the system S/DMS Network Manager is monitoring, and 
the software release installed on the system. For more information, see 
“Software release compatibility” in 

 

S/DMS Network Manager Introduction

 

, 
323-4001-102.

 

How commands, parameters, and responses are represented

 

Commands, parameters, and responses in this book are shown as follows.

 

System prompts and responses

 

System prompts and responses are printed as follows:

 

system-prompts and RESPONSES looks like this

 

Command strings

 

Command strings typed at the keyboard are printed in bold type, followed by 
a Return or Enter symbol (

 

↵

 

), as follows:

 

this is what you type  

 

↵

 

Type the command string exactly as shown, including spaces, and end by 
pressing the Return key.

Variable parameters are enclosed in angle brackets, as follows:

 

Install the software in directory <directory name> 

 

An explanation of the variable follows the command string, as follows: 

 

On-screen buttons and menu commands

 

Buttons and menu command items are printed in bold type as follows:

 

select the 

 

Controller Status

 

 command

where

<directory name> is the name of the directory used to...
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Hardkeys

 

Hardkey (keyboard keys) names are printed in plain type as follows:

 

press Return

 

Results of an action and comments

 

Results of an action and comments are printed in italic type, as follows:

 

The Controller Status dialog appears.

 

Screen illustrations

 

The screen illustrations in this book are black and white approximations of the 
images displayed by S/DMS Network Manager.

 

References in this book

 

S/DMS Network Manager can monitor various types of Northern Telecom 
SONET transmission systems, each of which has its own version of Northern 
Telecom Publication (NTP). Throughout this book, references to NTPs include 
an “nnnn” notation in place of the NTP version number. Substitute the 
appropriate NTP version number for the “nnnn” according to the type of 
system that S/DMS Network Manager is monitoring, as shown in the 
following table.

For example, if this book refers you to

 

 User Interfaces Description

 

, 
323-nnnn-301, and S/DMS Network Manager is monitoring a Northern 
Telecom OC-48 system, use NTP 323-1201-301 to obtain the appropriate 
information.

The following NTPs and other documentation are referred to, but not included 
as an integral part of the 

 

S/DMS Network Manager User Guide

 

.

•

 

System Description

 

, 323-nnnn-100

•

 

Signal Flow and Protection Switching Descriptions

 

, 323-nnnn-103

•

 

Performance Monitoring Description

 

, 323-nnnn-105

•

 

User Interfaces Description

 

, 323-nnnn-301

•

 

System Administration Procedures

 

, 323-nnnn-302

•

 

Software Administration Procedures

 

, 323-nnnn-303

 

System type NTP version number

 

OC-3/OC-12 1111

OC-48 1201

OC-192 1301

S/DMS AccessNode 3001
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•

 

Protection Switching Procedures

 

, 323-nnnn-311

•

 

Performance Monitoring Procedures

 

, 323-nnnn-520

•

 

Alarm and Trouble Clearing

 

, 323-nnnn-543

•

 

S/DMS Network Manager, Release 6.00 Planning Guide

 

, PG 96-04

 

• MOA, Release 2.00 Planning Guide, PG 95-11

 

•

 

HP Visual User Environment User's Guide

 

, Hewlett Packard Part No 
B1171-90042

•

 

HP Remote Access User's Guide

 

, Hewlett Packard Part No B1862-90011

•

 

HP-UX Installing Peripherals

 

, Hewlett Packard Part No B1864-90011

 

• HP-UX System Administration Tasks manual

 

•

 

Bellcore SONET BLSR Equipment Criteria

 

 TA-NWT-001230 (issue 2)
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Technical support and information

 

Additional technical support and information can be obtained by contacting 
the nearest service center. The service centers for the United States and Canada 
are listed in the following sections.

 

United States regional service centers

 

In the United States, contact the nearest regional service center for technical 
support and information.

 

For 24 hour emergency technical support

 

For assistance restoring service on equipment which has been carrying traffic and is out-of-service, call 
the following toll-free number:

 

800-275-3827 (800-ASK-ETAS)

For technical support from 8 a.m. to 10 p.m.

 

Call the following toll-free number

 

:

800-275-8726 (800-ASK-TRAN)

Southern Region

 

Northern Telecom Inc.
5555 Winward Parkway, Suite B,
Alpharetta, Georgia 30201-3895

(404) 661-4000

 

Northeast Region

 

Northern Telecom Inc.
200 Summit Lake Drive
Valhalla, New York 10595

(914) 773-2559

 

Central Region

 

Northern Telecom Inc.
475 Martingale Road
Schaumburg, Illinois 60173

(708) 706-8000 or 8389

 

Western Region

 

Northern Telecom Inc.
5575 DTC Parkway, Suite 150
Englewood, Colorado 80111

(303) 850-5600

 

Pacific Region (North)

 

Northern Telecom Inc.
2305 Camino Ramon
San Ramon, California 94583

(510) 867-2000

 

Southwest Region

 

Northern Telecom Inc.
2221 Lakeside Blvd., FL 9
Richardson, Texas 75082-4399

(214) 684-4195 or 1000

 

Pacific Region (South)

 

Northern Telecom Inc.
300 North Lake Avenue
Pasadena, California 91101

(818) 584-2000

 

Eastern Region

 

Northern Telecom Inc.
2010 Corporate Ridge
McLean, Virginia 22102

(703) 712-8487
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Canada technical assistance service centers

 

In Canada, contact the nearest technical assistance service center for technical 
support and information.

 

For 24-hour emergency technical support

 

For assistance with problems that can lead to payload-affecting failures or issues that prevent payload 
protection switching, call the following numbers:

 

 (800) 361-2465 or (514) 956-3500

For 24-hour emergency recovery

 

For assistance restoring service on equipment which has been carrying payload and is out of service, 
call ETAS at the following number:

 

613-226-5456

For non emergency support from 8:00 a.m. to 4:00 p.m.

 

Call the regional Field Service Engineering (FSE) group in your Technical Assistance Service Center.

 

FSE West
(Alberta)

 

Northern Telecom Canada Limited
10235, 101 Street
Edmonton, Alberta   T5J 3G1

(403) 441-3193

 

FSE West 
(British Columbia, Yukon, and Northwest Territories)

 

Northern Telecom Canada Limited
#410, 13251 Delf Place
Richmond, British Columbia   V6V 2A2

(604) 279-2258

 

FSE West
(Manitoba, North-Western Ontario)

 

Northern Telecom Canada Limited
180, 117 King Edward Street E.
Winnipeg, Manitoba   R3H 0Y3

(204) 788-7531

 

FSE West
(Saskatchewan)

 

Northern Telecom Canada Limited
PO Box 770
Regina, Saskatchewan   S4P 3A8
(1867 Hamilton Street, 8th floor)

(306) 791-7100 or (306) 791-7110

 

Ontario

 

Northern Telecom Canada Limited
PO Box 3000
Brampton, Ontario   L6V 2M6

(905) 452-2104

 

Quebec

 

Northern Telecom Canada Limited
PO Box 2110
St. Laurent, Quebec   H4L 4Y7

(514) 744-8750

 

FSE East (Newfoundland)

 

Northern Telecom Canada Limited
63 Thorburn Rd.
St. John’s, Newfoundland   A1B 3M2

(709) 722-2500 or 1-800-661-4827

 

FSE East (New Brunswick)

 

Northern Telecom Canada Limited
1 Brunswick Square, 4th Floor
Saint John, New Brunswick   E2L 4K2

(506) 632-8271 or (506) 632-8203

 

FSE East
(Nova Scotia, Prince Edward Island)

 

Northern Telecom Canada Limited
1701 Hollis St., Suite 900
Halifax, Nova Scotia   B3J 3M8

(902) 421-2301
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Understanding GNE 1-

 

This chapter describes the Graphical Network Editor (GNE). GNE is used by 
the system administrator to define and maintain a graphical representation of 
the network to be monitored by S/DMS Network Manager. GNE allows you 
to specify the controllers from which alarms are collected, and to enable or 
disable the alarm collection process.

The configuration you create with GNE is shown on the Graphical Network 
Browser (GNB) and is used by surveillance personnel to monitor the network.

GNE provides two separate types of windows for editing configurations: a 
network window and a subnetwork window.

The network window first appears when you open GNE. The window remains 
on the screen for the duration of your session. The network window provides 
a graphical view of the groups of network elements and the individual network 
elements that S/DMS Network Manager currently monitors for alarms. The 
network is shown as a series of connected graphical objects. You can use GNE 
to add, link, move, and delete the objects. These functions allow you to create 
a network layout. 

A subnetwork window appears when you double-click on a group in the 
network. The subnetwork window displays the network elements and 
subgroups that are part of the parent group. A separate subnetwork window 
exists for each group.

The icons used to represent network elements in S/DMS Network Manager are 
available in small, large, and variable size designations. Variable size 
designations enable you to tailor the appearance and behavior of the network 
element. This feature permits you to display more network elements in the 
display window.

Group nodes can contain a hierarchy of other groups and network elements, 
representing a network configuration. This feature enables you to design a 
network composed of several levels of detail.
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Groups are available in three shapes: rectangle, polygon, and multipoint line. 
Group shapes can help visually differentiate the function of the network 
elements and other groups located within the group. For example, group 
shapes can be used to identify system-level network components such as ring 
and linear systems. Also, group shapes can be used to identify geographic 
regions monitored by S/DMS Network Manager.

You can transfer network elements and groups between windows. Groups can 
be nested within other groups, enabling you to design a network composed of 
several levels of detail, however, you must ensure you do not violate group 
hierarchies.

Links can be added between groups or network elements to reflect the network 
connectivity. Links can connect groups or network elements within a single 
window or different windows. You cannot link groups to network elements.

GNE allows you to log in to the controller for a span of network elements. This 
login can be initiated from a network window or a subnetwork window. Once 
logged in to a controller, you can use the standard controller toolsets and tools.

In some cases, you can choose the user interface format displayed when you 
log in to the controller. If the controller recognizes your S/DMS Network 
Manager userID, you can choose a character-mode user interface or an X 
Window user interface.

You can also log in directly to the network elements monitored by S/DMS 
Network Manager, if the controller of the network element runs a version of 
software that supports the feature. For more information, see “Software release 
compatibility” in 

 

S/DMS Network Manager Introduction

 

, 323-4001-102.

If an external device is connected to S/DMS Network Manager, you can use 
GNE to display the user interface of that device.

For more information on logging in to a controller or network element, or 
connecting to an external device, see “Logging in to user interfaces” in 

 

S/DMS 
Network Manager Connectivity

 

, 323-4001-053.

If your S/DMS Network Manager monitors a system that contains a TA-1230 
ring, you can create a graphical representation of the ring on S/DMS Network 
Manager using GNE. This representation allows GNB surveillance personnel 
to monitor the high-speed traffic and the protection status of the ring.

The external alarm control feature enables you to configure S/DMS Network 
Manager and an external relay unit, so that on detection of certain alarm 
criteria within the network, external alarm equipment is activated. For more 
information on the external alarm feature, see “Controlling external alarms” in 

 

S/DMS Network Manager Installation and Administration

 

, 323-4001-202.
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The procedures for performing specific tasks with GNE are located in 
“Configuring a network” on page 2-1.

 

GNE network window

 

The network window appears when you first open GNE. This window allows 
you to create a network level view of the system monitored by your S/DMS 
Network Manager. The network window displays graphical objects, as shown 
in the following illustration, to represent the network elements and groups 
monitored.

 

NM-10564.1 (R6)

 

The network window can contain groups and individual network elements. 
You can use the network window to add, edit, and delete groups, log in to 
primary or backup controllers, and review the status of the alarm collection 
process for a particular controller. You can also use the network window to 
reposition and link groups or network elements and to create a representation 
of a TA-1230 ring configuration.

You can view the network elements and subgroups associated with a group by 
selecting the group and opening a subnetwork window.

GNE "View 1"

File Help

NM 10564.1(R6)

Central

10

Main

Ring 1

Controllers Login OptionsFault    Layout

48

North/South

East corridor
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Status icon

 

The status icon is located at the left of the menu bar in the network window, as 
shown in the following illustration. The status icon is not displayed in the GNE 
subnetwork window.

 

NM-10565.1 (R5)

 

The status icon indicates the state of the controllers monitored by S/DMS 
Network Manager. The status icon can be one of the following:

A green check mark indicates that all controllers 
monitored by S/DMS Network Manager are 
operating normally.

An inverted yellow triangle indicates that alarm 
reporting has been suspended on at least one 
controller or network element monitored by S/DMS 
Network Manager. All other controllers are operating 
normally.

A red X indicates that at least one controller 
monitored by S/DMS Network Manager is in the 
abnormal state.

GNE "View 1"

File Help

NM-10565.1

Status icon Controllers Login OptionsFault    Layout

Central

10

Main

Ring 1

48

North/South

East corridor
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GNE subnetwork window

 

The GNE subnetwork window displays groups and network elements 
currently monitored by S/DMS Network Manager. (See the following 
illustration.) A separate subnetwork window is available for each group 
displayed in the network configuration. To display a subnetwork window, open 
the group by double-clicking on it, or select the group and the Open <group> 
command from the File or group object menu.

 

NM-10566.1 (R6)

 

The name of the parent group that the network elements and groups are 
associated with is shown in the window title bar.

The subnetwork window allows you to create a customized subnetwork 
display topology. It is not required that the network elements and groups in a 
subnetwork be associated with any one particular controller. 

GNE: Central

Help

5

Ott

1

Alpha

12

Echo

48 48

48

File    Fault     Layout    Controllers    Login   Options
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GNE window menus

 

The menus and associated commands in the GNE network and subnetwork 
windows are almost identical. In some cases, commands are disabled (grayed 
out). There are two reasons for this: the command does not apply to the current 
action, or the feature invoked by the command cannot be executed because the 
controller runs a version of software that does not support the feature. For more 
information, see “Software release compatibility” in 

 

S/DMS Network 
Manager Introduction

 

, 323-4001-102.

 

Menu Bar

 

The menu bar is located above the display area of the network and subnetwork 
window. The menu bar contains a status icon and a menu bar. The following 
menus are available: File, Fault, Layout, Controllers, Login, Options, and 
Help. (See the following illustration.)

 

NM-10567.1 (R6)

 

The commands available through the GNE menu bar provide access to all 
functions of the S/DMS Network Manager software. Commands available 
through object menus, key combinations, and other techniques are intended as 
shortcuts for the functions provided by the menu bar commands.

 

File menu 

 

The File menu enables you to open a subnetwork window for a group, edit and 
delete annotations for a selected object, and exit GNE. You can also perform a 
variety of view-related commands that enable you to save a network view by 
its current (or different) name, revert to the last saved version of a view, switch 
views, and rename a view.

GNE "View 1"

Help

NM 10567.1(R6)

Menu bar

Central

10

Main

Ring 1

48

File    Fault     Layout    Controllers    Login   Options

North/South

East corridor
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Fault menu

 

The Fault menu enables you to suspend alarm reporting for individual network 
elements.

 

Layout menu

 

The Layout menu enables you to set up a graphical representation of the 
network the way you want it to appear. The commands in this menu enable you 
to add, change and delete groups and links, and add regenerators to a traffic 
link.

 

Controllers menu

 

The Controllers menu enables you to display a list of controllers monitored by 
S/DMS Network Manager and add a new controller to the network 
configuration.

 

Login menu

 

The Login menu enables you to log in to a network element, or the network 
element controller. You can gain access to the network element or controller 
through manual login dialogs or through an automated process, if the network 
element or controller recognizes your S/DMS Network Manager userID.

You can also use the Login menu to initiate a VT100 terminal emulation 
session on an external device.

 

Options menu

 

The Options menu enables you to control the information display in the 
network and subnetwork window and to set the default preferences to display 
and indicate alarms. A check mark beside a command means the command is 
active.

 

Help menu

 

The Help menu provides background information on GNE. You can also 
access an on-line legend that contains examples of the graphical elements that 
S/DMS Network Manager uses to represent a network. The legend also shows 
how the graphical elements are used to indicate various conditions in your 
network.

GNE also provides context-sensitive help that displays a detailed explanation 
of the item selected in the GNE. Context-sensitive help is available for menus, 
commands, windows, and dialogs. The help consists of a general description 
of the item, followed by a more detailed description for any selectable 
components.

 

Background menu

 

The network and subnetwork windows both have a background menu. The 
background menu appears when you click the menu mouse button on a blank 
part of a network or subnetwork window.
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The background menu enables you to add a link between network elements or 
groups, add a group, and save the network layout.

 

GNE Groups

 

Groups represent a collection of network elements and other groups in a 
system. Groups can be nested within other groups, enabling you to design a 
network composed of several levels of detail.

There are three group shapes: rectangle, polygon, and multipoint line. (See the 
following illustration.)

 

NM-10548.1 (R6)

 

Groups can be added to a network configuration by selecting the Add Group 
command from the Layout menu or the background menu. When this 
command is selected, the Group Attributes Display dialog appears. (See the 
following illustration.) This dialog enables you to specify the name, shape, fill 
pattern, and color for a group.

 

Note: 

 

The font size used to display the group name is controlled using the 
Preferences dialog. For more information, see “Preferences” on page 1-18.

GNE "View 1"

Help

NM 10548.1(R6)

Central

10

Main

Ring 1

Rectangle group 

Polygon group 

48

North/South

East corridor

Multipoint line group

File    Fault     Layout    Controllers    Login   Options
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NM-10633.1

 

Fill patterns are translucent and do not interfere with the display of objects in 
the underlying network. The colors available for displaying groups are a set of 
pastel shades that do not interfere with the colors used to show alarm states.

 

Note: 

 

File patterns cannot be defined for multipoint line groups.

The group appearance can help visually differentiate the function of the 
network elements and subgroups within the group.

You can display the network elements and subgroups associated with a group 
by opening a subnetwork window. To open a subnetwork window, 
double-click on the group, or select the Open <group> command from the File 
or group object menu.

For more information on adding a group, see “Adding a group” on page 2-7.

 

Editing a group

 

You can edit the appearance of existing groups in the GNE. To edit a group, 
select the group and the Edit <group> command from the Layout or group 
object menu. When this command is selected, the Group Display Attributes 
dialog is displayed, highlight handles appear on the group, and an alarm 
balloon placeholder appears. (The alarm balloon is included so the GNE user 
knows how functional alarm balloons appear in the GNB.) The group changes 
entered in the Group Attribute Display dialog are implemented in the group 
after the Apply button is selected. If the shape style (rectangle, polygon, or 
multipoint line) is changed, the group is converted to the specified shape. 

The information displayed on the face of the group can be repositioned, as 
well. The information includes the group name, total active alarm count, and 
alarm balloon placeholder. The information is moved while the group is in the 
edit mode. To move the information, select it with the left mouse button and 
drag it to the new location. The position of the information is constrained by 
the shape of the group. (The center of the total active alarm count must be 
within the perimeter of the group.)

Group Display Attributes

Group name :




Shape style:




Cancel       Ctrl+Escape  Add Group      Alt+Return  

NM-10633

Fill style:




Group color:
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The size or shape of a group can be changed using highlight handles that 
appear when the Edit <group> command is selected from the Layout or group 
object menu. Select a handle and drag it to the new location to change the size 
or shape of the group. Vertices for polygon groups and bend points for 
multipoint line groups can be added and deleted. A vertex or bend point is 
added by clicking on the line segment between two existing vertices or bend 
points. A vertex or bend point is deleted by selecting it and pressing the delete 
key on the keyboard.

For more information on Editing a group, see “Editing a group” on page 2-9.

 

Network elements

 

Network elements represent the individual elements in the system monitored 
by S/DMS Network Manager.

Network elements can appear in the network window and subnetwork 
windows. (See the following illustration.)

 

NM-10568.1 (R6)
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When you add a span of network elements to the network configuration, 
S/DMS Network Manager determines the function of each network element in 
the span, and automatically displays a node to represent each network element.

You can attach, modify, and delete textual annotations for network elements in 
GNE.

 

Network element size

 

S/DMS Network Manager uses three size designations to represent network 
elements. The size designations available are small, large, and variable. 
Network elements defined as variable can resize on demand, or in response to 
new alarms on the network. When a variable network element resizes, the icon 
changes from small to large. The large icon displays more information about 
that particular network element on the face of the icon.

A variable network element resizes from a large to a small display size when 
the alarms are acknowledged or cleared.

The following illustration shows a small and large network element.

 

NM-10609.1 (R6)

GNE "View 1"
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The size designation of a network element is controlled through the 
Preferences dialog.

 

Network element names and numbers

 

Network elements are identified by a name and number that appears directly 
below the node. You can change the network element name but not the number 
using S/DMS Network Manager. The network element number is assigned in 
the system. Also, you can select the size of the font used to display the network 
element name and number. The available sizes are small, variable, and large.

 

Note: 

 

If you are using a dark background color to display your network, it 
can be difficult to read the network element name and number. Use the 
default background color (grey) for best visibility. This feature is 
controlled using the NE Names Background command in the Preferences 
dialog.

The display of network element names and numbers is controlled through 
commands in the Options menu or the Preferences dialog. If you use the 
Options menu, the display preferences are applied to the active window. If you 
use the Preferences dialog, the display preferences are applied throughout all 
GNE windows.

 

Network element graphics and labels

 

Information about network elements is displayed on the face of the icon. The 
information displayed on the icon depends on the size designation of the 
network element. Small network elements display a graphic that identifies the 
node type. Large network elements display a graphic that identifies the node 
type and a label that identifies the product type. The information displayed by 
variable network elements changes accordingly with the size designation of 
the network element.

 

Note: 

 

The node type graphic on a small network element is replaced by a 
letter indicating the highest severity active alarm that is affecting the 
network element.

Node type graphics used by S/DMS Network Manager are shown in the 
following illustration.

 

NM-10643.1 (R6)

S/DMS TransportNode ADM

S/DMS TransportNode Regenerator

S/DMS TransportNode LTE

S/DMS AccessNode FCOT

S/DMS AccessNode RFT

DV45 Video Codec

Tellabs Titan 5500 DCS
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Transferring groups and network elements

 

Groups and network elements can be repositioned within the network. The 
middle mouse button is used to select the group or network element and drag 
it to the new location. 

The new location for the group or network element can be within the same or 
different window. If the group or network element is connected to a group or 
network element in another window, a link continuation icon appears at the 
end of the link in each of the windows. For more information, see “Link 
continuation icons” on page 1-15.

Groups can be nested within other groups, enabling you to design a network 
composed of several levels of detail, however, you must ensure you do not 
violate group hierarchies.

 

Network element and group links

 

Links show the interconnections between individual network elements, and 
groups of network elements, in the system monitored by S/DMS Network 
Manager. You can add, change, and delete the links to create the desired 
display.

Links can connect groups or network elements within a single window or 
different windows. You cannot link groups to network elements.

Three basic types of links are used by S/DMS Network Manager to show 
network element and group connectivity: fiber, electrical, and control network 
(CNet). S/DMS Network Manager uses a different color and line pattern to 
distinguish the different types of links. (See the following illustration.)

 

NM-10551.1 (R6)NM 10551.1
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If your S/DMS Network Manager monitors a system containing a TA-1230 
ring, special traffic display links connect the network elements and groups that 
comprise the ring. For more information, see “Ring traffic display links” on 
page 1-15.

Each link has an object menu that enables you to edit the annotations for a link, 
delete a link, or change the link type.

 

Note: 

 

The Change <link> to and Delete <link> commands are disabled 
(grayed out) if the link is part of a TA-1230 ring. For more information, see 
“Ring traffic display links” on page 1-15.

 

Connect network elements or groups dialog

 

The Connect Network Elements or Groups dialog allows you to create the 
links between network elements or groups. Links provide a graphical 
representation of connectivity in the system. 

The Connect Network Elements or Groups dialog appears when you select the 
Add Link command from the Layout menu or the background menu found in 
the GNE network and subnetwork window. (See the following illustration.)

 

NM-10142.1 (R6)

 

Note: 

 

Links created with S/DMS Network Manager are for display 
purposes only, and have no effect on the configuration or connectivity of 
an operational system.

NM-10142.1(R6)

For any pair of Network Elements or Groups

you wish to connect:

OK

1)   Select the link type you wish to make

Link Type:




Fiber



CNET



Electrical

2)   Click on the Network Elements or Groups

to be connected.



When you have finished connecting Network Elements,

or Groups,click on the OK button.
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When the Connect Network Elements or Groups dialog is open, the pointer 
changes to the shape of a hand to indicate that GNE is in the link mode. You 
can now select the network elements, or the groups you want connect. After 
selecting the second network element or group, the chosen link type appears. 
You cannot link groups to network elements. If you attempt to connect a group 
to a network element a warning beep sounds.

When connecting network elements or groups located in separate windows, a 
link continuation icon is automatically placed on the link, at the edge of each 
window containing the linked nodes. The link continuation icon indicates that 
the link continues to another window.

Add as many links as desired. Links become increasingly difficult to 
distinguish as the number increases. 

When you finish adding links, select the OK button to close the dialog.

 

Link continuation icons

 

The link continuation icon identifies links that span two windows. The icon 
indicates that this link is connected to a network element or group in another 
window. To view the window that contains the remainder of the network 
elements or groups in the link, double-click on the link continuation icon. The 
other window appears on the screen. When both windows are on the screen, 
the link continuation icons in both windows are highlighted to show links that 
are related. 

Move the link continuation icon anywhere within its window by selecting the 
icon with the Modify mouse button and dragging it to the desired location in 
the window.

 

Ring traffic display links

 

S/DMS Network Manageruses ring traffic display links for systems that 
contain a TA-1230 ring. If your S/DMS Network Manager monitors this type 
of system, and a representation of that ring has been created, special traffic 
display links show the configuration of the ring.

The traffic display links appear in GNE as thick gray lines that connect the 
end-point ADMs in the ring. The following illustration shows a typical GNE 
TA-1230 ring with traffic display links.
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NM-10550.1 (R6)

 

These links show the connections between the end-point ADMs in the ring. 
When the ring configuration is viewed on GNB, different colors and line 
patterns are applied to the traffic display links to show the state of the 
high-speed traffic and the protection status of the ring.

 

Configure Regenerators dialog

 

The Configure Regenerators dialog is used to modify the appearance of a 
TA-1230 ring that already exists on GNE. This dialog is available only if your 
S/DMS Network Manager monitors a system that contains a TA-1230 ring.

The Configure Regenerators dialog appears when you select the Attach 
Regenerators command from the Layout menu. (See the following 
illustration.)

 

NM-10268.1

 

The ADMs in a TA-1230 ring can be geographically dispersed. In such a case, 
the adjacent ADMs in the ring are connected through a series of regenerators.

The Configure Regenerators dialog allows you to create a true representation 
of the TA-1230 ring by adding the regenerators to the ring configuration 
display. The nodes used to represent the regenerators can be small, large, or 

GNE: Ring 1

Help

NM 10550.1 (R5)

ADM 2

ADM 3

ADM 1Ring traffic display links

48

48 48

File    Fault     Layout    Controllers    Login   Options

NM-10268.1

Use this command to add regenerators between two ring ADMs



To add one or more regenerators:

1. Click on the first Ring ADM.

2. Click on one or more regenerators.

3. Click on the second Ring ADM.



When done, click on the OK button.

OK              Alt+Return  Cancel           Ctrl+Escape
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variable-sized network elements. A graphic is used to identify network 
elements that are regenerators. The diamond indicates TransportNode, and the 
small square inside represents a regenerator. This graphic appears on the face 
of the network element. For more information, see “Network elements” on 
page 1-10.

As you add regenerators to the ring configuration, the traffic display link 
between the ADMs is modified to show how the link is routed through each 
regenerator in the ring.

You can also use this dialog to modify an existing ring configuration displayed 
on GNE by rerouting the traffic display link through different regenerators.

 

Alarm balloons

 

Alarm balloons in GNE are used only to aid in the placement of the groups and 
network elements in the window. The GNE alarm balloons do not provide any 
indication of alarms. (See the following illustration.)

 

NM-10571.1 (R6)

 

You can turn the alarm balloon display on and off by using the Display 
Highlighting command in the Options menu. With the balloons shown, you 
can tell whether the groups and network elements overlap the alarm balloons.

 

Network display
The network you create with GNE is saved in the S/DMS Network Manager 
database. This configuration is then used by the Graphical Network Browser 
(GNB) to display alarm information from the network elements in the system. 
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When you change and save a network configuration, the S/DMS Network 
Manager database is immediately updated. The new configuration appears on 
the GNB, and is used as the default for GNE and GNB until you make further 
changes.

The GNB can be used to override the default display preferences set in the 
GNE.

View selection
Multiple independent views allow you to display the network using a specific 
view. Network elements can be placed in different groups and can possess 
different connectivity in each view (with the exception of Traffic Display Links 
because they are not specified in the GNE and are an attribute of the network 
itself). Each view displays all network elements monitored by S/DMS 
Network Manager. Only relative positioning, connectivity, and groupings of 
network elements are different. Each view can have its own customized layout, 
group hierarchy, background maps, and default preferences.

If more than one view is available, you are prompted to select a view when the 
GNE is started. Use the GNE View Choice dialog for selecting a view. All GNE 
users have the capability of displaying any existing view. (See the following 
illustration.)

NM-10607.1

You can also use the GNE View Choice dialog to rename, copy, or delete a 
view.

For more information, see “Managing network views” on page 2-3.

Preferences
The GNE Preferences dialog enables you to set display options for GNE. The 
display options set in the Preferences dialog apply to all groups in GNE and 
GNB, for that view and user.

Default display preferences for GNE are hardcoded into S/DMS Network 
Manager. The hardcoded display preferences can be changed for a network 
view by resetting the preferences and selecting the OK button in the GNE 
Preferences dialog. The display preferences set for a view in the GNE also 
become the default display preferences for that view in the GNB.

Rename

Please choose the view in which to display the network:

Physical
Logical
Management Domain

DeleteCopy 

Use  Exit  
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To display the Preferences dialog, select the Preferences command from the 
Options menu. The Preferences dialog moves to the foreground if it is already 
open when you select this command. (See the following illustration.)

NM-10572.1 (R6)NM-10572.1(R6)

NE Size: small

variable
large

NE Font Size: small

variable

Group Font Size: small

large

large

Display: NE Names

NE Numbers
NE Names Background

Group Names Background

Background Maps

Alarm Banner

OK  

Other: Alarm Beeping

Raise Root Group on Alarms
Auto Update Alarms Dialog

Use Multiple Connection Managers

Apply  Cancel  

Preferences
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Display options in the Preferences dialog are grouped into the following 
classifications.

For more information on setting network display options for the GNE, see 
“Configuring a network” on page 2-1.

Background maps
Background maps provide a visual reference point or context for the group and 
network element layout displayed in GNE and GNB. Maps are loaded into the 
background of a network window by selecting the Load Background Map 
command from the Options menu. The Load Map dialog appears when this 
command is selected.

NM-10635.1

NE Size Sets all network element node sizes to small, 
variable, or large.

NE Font Size Sets the font size for the network element name and 
number to small, variable, or large.

Group Font Size Sets the font size for the group name to small or 
large.

Display Controls the display of the network element names 
and numbers, default background color (grey), 
background maps, and Alarm Banner. 

Other Controls how S/DMS Network Manager reacts when 
an alarm is raised, and provides the option of using 
multiple connection managers.
Options for the display of alarms include an audible 
beep, the network window appearing over top of the 
other display windows, and the Alarms dialog being 
automatically updated.

Load map for : Network window

Filename:



./

../

Arizona.gif

Canada.dxf

Canada.gif

Colorado.gif

NorthAmerica.dxf




File type:




Directory:




OK      Alt+Return  Unload map  Cancel       Ctrl+Escape  

all

/usr/bin/noc/maps/

GIF DXF

NM-10635
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When a background map is loaded into a window, the map is displayed using 
a default scale and position. The GNE user can modify the scale and position 
of the map by using the Map Tools palette. (See the following illustration.)

NM-10611.1 (R6)

Keyboard shortcuts are available for some of the functions in the Map Tools 
palette:

• f for Fit To Window

• z for Zoom Out

• Z for Zoom In

• arrow keys for Pan Up, Pan Down, Pan Left, and Pan Right

You can modify the position of all background maps. You can modify the scale 
of a vector-based map (DXF format). You cannot modify the scale of an 
image-based map (GIF format).

The map display is controlled by the Display Background Map command in 
the Options menu.

For more information, see “Managing background maps” on page 2-33.

Map Tools

File

NM-10611.1(R6)

Pan Left - Move the 

view of the map left by

a fixed amount.

Pan Down - Move the

view of the map

downwards by a fixed

amount.

Fit To Window -

Scale and position

the map so that it is

entirely visible in the

current dimensions

of the window.

Pan Up - Move the view

of the map upwards by a 

fixed amount.

Pan Right - Move the 

view of the map right by

a fixed amount.

Interactive Pan - Move

the map by dragging an

outline of the window to

a new position.

Interactive Zoom - Scale and

position the map by redefining

the size of the window. 

Zoom In - Scale the

map by a factor of 2.

Zoom Out - Scale the

map by a factor of 1/2.
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Bridging controller software
The software release installed on a controller consists of application software 
S/DMS Network Manager for the controller, and S/DMS Network Manager 
server software. The server software enables S/DMS Network Manager to 
communicate with, and monitor, the controller.

The controllers monitored by S/DMS Network Manager must have the correct 
controller software installed in order to support connection management, 
service assurance, and facility provisioning.

Note: Controller software is also known as server software.

For controllers on which S/DMS TransportNode OC-48 Rel 11, OC-3/OC-12 
Rel 10, or OC-192 Rel 1 software is installed, a special bridging operation can 
be performed from S/DMS Network Manager to ensure that the controller can 
support all Release 6 features.

Bridging is the process of transferring the necessary components of the S/DMS 
Network Manager server software to the controller, without modifying, 
upgrading, or restarting the existing application software resident on the 
controller.

Bridging controller software is enabled (or disabled) in the Controller Details 
dialog when setting up the graphical network configuration with S/DMS 
Network Manager. Bridging can be enabled only if the controller can support 
connection management, service assurance, and facility provisioning. The 
current bridging status for each controller can be viewed in the Controller List 
dialog. To determine whether a controller can be bridged, and to determine the 
current status of bridging on a particular controller, see “Bridging status” on 
page 1-30.

If bridging is enabled for a controller, server software automatically transfers 
from S/DMS Network Manager to the controller when the new configuration 
is saved in GNE. For more information on enabling bridging, see “Controller 
Details dialog” on page 1-32.

GNE Controller List dialog
The GNE Controller List dialog shows the current status of the S/DMS 
Network Manager alarm collection process, and provides information about 
each controller being monitored by S/DMS Network Manager.

To display the Controller List dialog, select the Show List of Controllers 
command from the Controllers menu.
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The GNE Controller List dialog contains a collection status field, a collection 
control button, four display section radio buttons, and a controller information 
list. 

Note: If the name of a controller is changed, the name displayed in the 
Controller Details dialog is updated only when the controller is re-added 
to the network configuration. It is not updated dynamically.

The information contained in the controller list depends on which display 
selection button is selected. The controller list can show the activity and status 
of each controller (Controller Status button selected), a textual message 
relating to each controller (Controller Comments button selected), information 
about the software release installed on each controller (S/W Releases button 
selected), or bridge status and version of S/DMS Network Manager to 
controller software relation (Bridging status button selected).

The following illustration shows the Controller List dialog with the Display 
Controller Status button selected.

NM-10573.1 (R6)

Collection status field
The S/DMS Network Manager Collection status field indicates the current 
status of the alarm collection process as follows:

Running The S/DMS Network Manager alarm collection 
process is operating and collecting alarms from the 
controllers.

Stopped The S/DMS Network Manager alarm collection 
process is stopped and not collecting alarms from any 
controllers.

NM-10573.1(R6)
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Collection control button
The collection control button is located beside the Collection Status field. The 
collection control button is a toggle button. It allows you to control the state of 
the S/DMS Network Manager alarm collection process. Each time you select 
the button, the alarm collection state toggles between Start and Stop. The label 
inside the button indicates what action you can take.

The collection control button is used only when you want to stop the S/DMS 
Network Manager alarm collection process. When you stop the alarm 
collection process, S/DMS Network Manager suspends all connections to the 
controllers it monitors. No alarms are collected from any controller when the 
alarm collection process stops, and all communication with the controllers 
halts. This button is used only when shutting down S/DMS Network Manager 
for maintenance or upgrade.

Note: Do not confuse the collection control button with the 
Suspend/Resume all NE Reporting to <controller> command. The 
command is available in the object menu for a controller list item and is 
used to control alarm reporting for the network elements associated with a 
controller.

Controller information list
The information provided in the controller information list depends on which 
display selection button you select. You can display the status of each 
controller monitored by S/DMS Network Manager, comments about each 
controller, the software release running on each controller, or the status of 
software bridging for the controller.

Controller status
When you select the Controller Status button, the controller information list 
provides details on each controller monitored by S/DMS Network Manager. 
The current activity, and the status of alarm collection and reporting for each 
controller is shown in the controller information list. (See the following 
illustration.)
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NM-10513.1 (R6)

The list is divided into two parts: one for the primary controller and one for the 
backup controller. If S/DMS Network Manager monitors only one of these 
controllers, only that part of the list is filled in. The controller list is sorted 
alphabetically, according to Primary controller name.

The Controller List shows the names and IP addresses of each controller, the 
current activity of the controller, and the status of alarm collection and 
reporting from the controller.

The Activity field shows the state of operation for each controller monitored 
by S/DMS Network Manager. The following values can appear in the Activity 
field.

Active The controller is in the active state, managing the span 
of network elements.

Inactive The controller is in the inactive state, not managing the 
span of network elements at this time. The controller 
is available if needed.

OOS The controller is out of service and is not 
communicating with S/DMS Network Manager.

Busy This controller is already monitored by the maximum 
number of S/DMS Network Managers.

If you want to see which S/DMS Network Managers 
are monitoring this controller, select the Edit 
command from the Module controller status list menu. 
The Availability field in the resulting Controller 
Details dialog shows the S/DMS Network Managers 
monitoring the controller.

NM-10513.1(R6)
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The Status field shows the state of the S/DMS Network Manager alarm 
collection process as it relates to each controller.

Unknown The state of operation of the controller is unknown 
because S/DMS Network Manager cannot 
communicate with the controller.

This state can be caused by a failure of the 
communication link between S/DMS Network 
Manager and the controller, or by a user initiated 
action that manually stops the S/DMS Network 
Manager alarm collection process. 

If the communication link to a controller fails, S/DMS 
Network Manager cannot determine the operating 
state of the controller. 

If a user stops the alarm collection process, all 
communication between S/DMS Network Manager 
and the controllers terminates, thereby preventing 
S/DMS Network Manager from determining the 
operating state of the controller.

n/a The Activity field is not applicable to this controller.
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The alarm collection process enables S/DMS Network Manager to 
communicate with, and gather alarms from the controllers it monitors. If the 
alarm collection process is stopped, communication between S/DMS Network 
Manager and all controllers it monitors also stops. The following values can 
appear in the Status field.

Collecting The alarm collection process is operating and S/DMS 
Network Manager is collecting alarms from the 
controller.

Not collecting S/DMS Network Manager is not communicating with 
the controller, and therefore not collecting alarms 
from the controller. This condition might be because 
the controller is not active, or because a user manually 
stops the S/DMS Network Manager alarm collection 
process by selecting the collection control button.

Suspended S/DMS Network Manager is not reporting alarms for 
this controller because alarm reporting has been 
suspended for the controller or an associated network 
element. An inverted triangle appears in the left-most 
column beside the primary controller name when 
alarm reporting is suspended.

Collecting/Sus At least one, but not all network elements have 
suspended alarm reporting. An inverted triangle in the 
left-most column identifies the primary controller of 
the network elements with suspended alarm reporting.

Unknown The alarm collection state is unknown because S/DMS 
Network Manager alarm collection process has been 
stopped by a user.

n/a The Status field is not applicable to this controller.
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Together, the Activity and Status fields allow you to determine the following:

• the current operating state

• the status of S/DMS Network Manager alarm collection and reporting

The normal operating state is a primary controller is in the active state, and a 
backup controller, if there is one, in the inactive state. If the primary and 
backup controllers are in any other state, an X appears in the first column on 
the left side of the list beside the controller name.

The following table lists and describes the possible combinations that might 
appear in the Activity and State fields.

Activity State Indicates

Active Collecting S/DMS Network Manager is collecting and 
reporting alarms from the controller. This 
combination indicates normal operation.

OOS Not collecting S/DMS Network Manager cannot collect 
alarms; the controller is out of service.

Busy Not collecting S/DMS Network Manager cannot collect 
alarms because the controller is already 
being monitored by the maximum number 
of S/DMS Network Managers.

Inactive Not collecting S/DMS Network Manager is not collecting 
alarms because the controller is in the 
inactive state. S/DMS Network Manager 
collects alarms only from active controllers. 

Unknown Not collecting S/DMS Network Manager cannot collect 
alarms because the controller is not running 
a compatible version of software, or S/DMS 
Network Manager is trying to connect to the 
controller.

Any of the 
above

Suspended A GNE user has manually suspended alarm 
reporting for this controller.

Unknown Unknown The S/DMS Network Manager alarm 
collection process has been stopped. S/DMS 
Network Manager cannot communicate 
with the controller and no alarm information 
can be collected or reported for the 
controller.
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Controller comments
When you select the Controller Comments button, the controller information 
list shows the names and IP addresses of the primary and backup controllers, 
and a comment about each controller. (See the following illustration.)

NM10535.1 (R6)

Controller comments are recorded by GNE users when setting up the network 
configuration. The controller comments are optional, but provide additional 
information about a controller. If there are no comments for a controller, the 
Controller Comments field for that controller is blank. For information on 
recording or editing the controller comments, see “Controller Details dialog” 
on page 1-32.

NM 10535.1(R6)

Done          Alt+Return  

Controller List



Network Manager Collection Status:  Running

Controller Comments



Central group SOC OPC



OPCM100P located in OAM shelf OAM001

T1 to Primary OPC on CISCO 3000

Primary Controller



OPCM001P/47.45.0.246

OPCM002P/47.46.3.218

OPCM003P/47.46.0.255

OPCM004P/47.45.1.12

Backup Controller



<none>

<none>

OPCM0038/47.46.1.14

<none>








Stop

Controller Status



Controller Comments


S/W Releases


Bridging Status




Display
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Software releases
When you select the S/W Releases button, the controller information list 
shows the software release installed on each primary and backup controller 
monitored by S/DMS Network Manager. (See the following illustration.)

NM10536.1 (R6)

The S/W Release column identifies the name of the product-specific software 
release installed on each controller. The software release name identifies the 
product that the software is used for (for example, OC-48), and the software 
version (for example, REL 10.0).

Bridging status
When you select the Bridging Status button, the controller information list 
shows bridging status for each controller. (See the following illustration.)

NM10574.1R6

NM-10536.1(R6)

Done          Alt+Return  

Controller List



Network Manager Collection Status:  Running

S/W Release



OC-48 REL 10.00

OC-3/OC-12 REL 8.01

OC-3/OC-12REL 9.00

OC-48 REL 10.00

S/W Release



<unknown>

<unknown>

OC-3/OC-12 REL 9.00

<unknown>

Stop

Primary Controller



OPCM001P/47.45.0.246

OPCM002P/47.46.3.218

OPCM003P/47.46.0.255

OPCM004P/47.45.1.12

Backup Controller



<none>

<none>

OPCM0038/47.46.1.14

<none>








Controller Status



Controller Comments


S/W Releases


Bridging Status




Display

NM 10574.1(R6)

Done          Alt+Return  

Controller List



Network Manager Collection Status:  Running

Bridge Status



unknown

not required

not required

not required

Stop

Primary Controller



OPCM001P/47.175.0.89

OPC004PP/47.105.10.228

OPC23PPP/47.105.2.75

OP26APP/47.214.96.103

Backup Controller



<none>

<none>

<none>

OPC26APB/47.214.16.103








Version



6.0

6.0

6.0

6.0

Bridge Status









not required

Version









6.0

Controller Status



Controller Comments


S/W Releases


Bridging Status




Display
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The controllers monitored by S/DMS Network Manager must have the correct 
controller software installed in order to support connection management, 
service assurance, and facility provisioning. (Controller software is also 
known as server software.) If the controller does not have the appropriate 
server software installed, a special software bridging operation must be 
performed on the controller. For more information, see “Bridging controller 
software” on page 1-22.

The Controller List shows the names and IP addresses of each controller, the 
Bridging status for the controller, and the version of S/DMS Network Manager 
server software installed on the controller. 

The Bridge Status field shows the state of the bridging process for each 
controller. The following values can appear in the Status field.

required The controller needs to be bridged to enable certain 
S/DMS Network Manager Release 6 features.

not required The controller does not need to be bridged because it 
runs a software release that supports all S/DMS 
Network Manager Release 6 features. Also, “not 
required” appears in this field if the controller runs a 
software release prior to OC-48 Rel 11 or 
OC-3/OC-12 Rel 10 that cannot be bridged.

pending Bridging has been requested, and is about to be 
performed. The job is queued.

xfer in progress Bridging files are being transferred to the controller.

install in progress S/DMS Network Manager server software is being 
installed on the controller.

complete Bridging is complete.

fail Bridging failed and will not be retried automatically.

unknown The bridging state of the controller is unknown. 

disabled Bridging can not be performed because bridging has 
been disabled by the GNE user.

another NM bridging Another S/DMS Network Manager is bridging the 
controller. 
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The Version field identifies the S/DMS Network Manager release supported by 
the server software installed on the controller.

Use the Bridging Status field to determine whether the server software on the 
controller requires bridging to support Release 6 features.

Controller information list menu
The controller information list has a menu that allows you to log in to a 
controller, edit the details of a controller, and control alarm reporting for the 
network elements associated with a controller. This menu is available on all 
controller information list displays.

Controller Details dialog
The Controller Details dialog enables you to record details of the new 
controller that you are adding to the network configuration. You can also edit 
the details of an existing controller.

All Controller Details dialogs provide two separate columns of information. 
One column describes the primary controller, and the other is for the backup 
controller. Either column can be used for the primary or backup controller.

When you add a new controller, or edit the details of an existing controller, the 
only information you need to supply is the IP address of the controller. The 
remaining details automatically fill in when S/DMS Network Manager 
connects with the controller.

Once you select the Validate button, the IP address is checked, and the 
remainder of the fields in the dialog fill in with the details of the controller at 
that address. If recording the IP address of only one controller in the span, 
leave the remaining IP address field blank.

In some systems, the controllers can support two user interface formats. If so, 
the Login type buttons allow you to specify which format to display when a 
user logs into the controller. If not, these buttons are disabled.

Some controllers are not able to support all Release 6 features, but can do so if 
new S/DMS Network Manager server software is installed on the controller. 
When adding a controller, the Controller Details dialog provides you with the 
option of performing a bridging operation on the controller. Bridging 
automatically installs the required S/DMS Network Manager server software 
on the controller. If the controller can be bridged, the Bridging Disable radio 
button is selected by default. The enable and disable radio buttons are both 
grayed out if the controller cannot be bridged. For more information, see 
“Bridging controller software” on page 1-22.
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The Controller comments field is an optional field that enables you to enter a 
comment to add to the controller details. You can enter any comment, up to 40 
characters in length. The comment is displayed in the GNE and GNB 
Controller List dialogs when you select the Display Controller Comments 
button. The comment is also displayed in the GNB Controller Details dialog.

There are two different versions of the Controller Details dialog. Each dialog 
is described in the following sections. The version of the dialog displayed 
depends on the task you perform. The tasks include:

• adding a controller

• editing the details of a controller

Add a new controller
Add a new controller to a network by selecting the Add a New Controller to 
<group> command from the Controllers menu or group object menu. When 
you select this command, the Controller Details dialog appears. (See the 
following illustration.) The network elements are placed in the window that 
was active prior to accessing the Controller Details dialog. In the following 
illustration, the network window was active prior to initiating the addition of a 
controller.

NM-10518.1 (R6)

OK          Alt+Return  

Use this command to add new Controllers to your network

Network Elements added during this operation will appear in "Top Level" (in this view).




Controller Name:

Controller Function:


Controller S/W Load:

Controller Availability:


Network Manager Connections:












Login Type:

Cancel     Ctrl+EscapeApply

IP Address:

Validate

Controller Name:

Controller Function:


Controller S/W Load:

Controller Availability:


Network Manager Connections:












Login Type:

IP Address:

Validate

Display Character Session

Display X-Window Session




Display Character Session

Display X-Window Session




Controller Comments:

Enabled

Disabled




Bridging:
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To add a controller to a group, open the group before accessing the Controller 
Details dialog. The name of the group that the controller is being added to is 
indicated in the dialog. (See the following illustration.)

NM-10517.1 (R6)

Edit a controller
To edit the details of a controller or record the IP address of a second controller 
in a span, choose the Edit <controller> command from the controller list menu 
in the Controller List dialog. When you do so, an Edit Controller Details dialog 
appears. (See the following illustration.)

NM-10537.1 (R6)

OK          Alt+Return  

NM-10518.1

Controller Name:

Controller Function:


Controller S/W Load:

Controller Availability:


Network Manager Connections:












Login Type:

Cancel     Ctrl+EscapeApply

IP Address:

Validate

Controller Name:

Controller Function:


Controller S/W Load:

Controller Availability:


Network Manager Connections:












Login Type:

IP Address:

Validate

Display Character Session

Display X-Window Session




Display Character Session

Display X-Window Session




Controller Comments:

Enabled

Disabled




Bridging:

Use this command to add new Controllers to your network

Network Elements added during this operation will appear in "East corridor"

OK          Alt+Return  

NM 10519.1

Use this command to edit the Controller details




Controller Name:

Controller Function:


Controller S/W Load:

Controller Availability:


Network Manager Connections:

Cancel     Ctrl+Escape

IP Address:

Validate

Controller Name:

Controller Function:


Controller S/W Load:

Controller Availability:


Network Manager Connection:

IP Address:

Validate

Display Character Session

Display X-Window Session




Login Type:

OPCP201P

Primary/Active

OPCAL1BCH

Available




Display Character Session

Display X-Window Session




Login Type:

Controller Comments:

47.105.10.215




Enabled

Disabled




Bridging:

bmerh352

bmerhfd2

bmerhb08

bmerhac4
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This Controller Details dialog provides detailed information about the 
controller you selected in the Controller List dialog. Use this dialog to change 
the IP address of a controller, or to add the IP address of a second controller if 
S/DMS Network Manager currently monitors only one controller in the span.

If the controller of a span changes, and you want S/DMS Network Manager to 
monitor the new controller, you can edit the IP addresses in the Controller 
Details dialog. Once you validate the new IP address, S/DMS Network 
Manager begins to monitor the new controller.

If S/DMS Network Manager currently monitors only a primary or a backup 
controller, and you want to add the IP address of a second controller, use the 
Controller Details dialog to record the IP address of the second controller.

You can also use this dialog to edit or add a comment about the span, or to 
enable or disable Bridging of the S/DMS Network Manager server software on 
the controller.
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Configuring a network 2-

 

This chapter describes how to configure a network using the Graphical 
Network Editor (GNE). GNE is used to create and maintain a graphical 
representation of the network monitored by your S/DMS Network Manager.

GNE allows you to specify the controllers that you want S/DMS Network 
Manager to monitor. Once this is done, you can define the topology of the 
network by manipulating and connecting the groups and network elements. 
The topology you create with GNE does not affect the network element 
configurations in an operating system nor does it necessarily correspond to the 
actual connections in the system.

The network you create with GNE is saved in the S/DMS Network Manager 
database. This configuration is then used by the Graphical Network Browser 
(GNB) to display alarm information from the network elements in the system. 

When you change and save a network configuration, the S/DMS Network 
Manager database is immediately updated. The new configuration appears on 
the GNB, and is used as the default for GNE and GNB until you make further 
changes.

 

Requirements

 

To perform the procedures in this chapter, you must do the following:

• read the conventions described in “About this guide” on page vii

• read “Understanding GNE” on page 1-1

• ensure you have a userID and password that allow you access to GNE 
(admin or layout access class)

• log in to S/DMS Network Manager and open GNE. For more information, 
see “Logging in and opening S/DMS Network Manager tool” in 

 

S/DMS 
Network Manager Connectivity

 

, 323-4001-053

• ensure the controllers have been properly configured. For Northern 
Telecom Operations Controllers (OPC), see “Configuring the OPC” in 

 

S/DMS Network Manager Installation and Administration

 

, 323-4001-202
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Chapter task list

 

The following table lists the network configuration tasks. GNE might restrict 
you from performing some tasks if you try to perform them out of sequence, 
or if the feature is not available on your S/DMS Network Manager.

 

Task Page

 

Managing network views 2-3

Viewing controller status 2-6

Adding a group 2-7

Editing a group 2-9

Deleting a group 2-11

Adding a new controller 2-12

Deleting a controller 2-16

Repositioning a network element or group 2-17

Connecting groups and network elements 2-19

Modifying network element connections 2-21

Displaying link continuations 2-23

Arranging link continuation icons 2-24

Adding or deleting regenerators on a ring configuration 2-25

Changing the network element icon display size 2-29

Controlling the display of the name or number of an object 2-33

Attaching, editing, and deleting annotations 2-32

Managing background maps 2-33

Controlling alarm collection 2-36

Controlling alarm reporting 2-38

Viewing and editing the details of a controller 2-41

Saving or reverting the configuration 2-45
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Procedure 2-1

 

Managing network views

 

Use this procedure to select or create a view to display a network. Views can 
have custom layouts, group hierarchies, background maps, and display 
preferences. For example, a view can be defined that displays the network 
from a physical perspective, with the network elements geographically aligned 
with a background map.

The Graphical Network Editor (GNE) user is presented with the View Choice 
dialog when the session starts. The View Choice dialog allows you to use, 
rename, copy, or delete a view.

 

Note: 

 

You can also select a view from the command line when starting 
S/DMS Network Manager. If this method is used, the View Choice dialog 
is bypassed. For more information, see “Logging in and opening an 
S/DMS Network Manager tool” in 

 

S/DMS Network Manager Connectivity

 

, 
323-4001-053.

The display preferences set in the GNE become the defaults for the Graphical 
Network Browser (GNB). The GNB user can choose new preferences, if 
desired.

Before starting this procedure, read “Requirements” on page 2-1.

 

Action

 

Step Action

1

 

When you start GNE, the View Choice dialog appears. The View Choice 
dialog enables you to select an existing network view or create a new network 
view using copy and rename.

For more information on how to start GNE, see “Logging in and opening an 
S/DMS Network Manager tool” in 

 

S/DMS Network Manager Connectivity

 

, 
323-4001-053.

 

—continued—

 

If 

 

you want to

 

Then 

 

select a view step 2

rename an existing view step 3

copy a view step 8

delete a view step 13
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Procedure 2-1 (continued)

 

Managing network views

 

Step Action

2

 

Select the view in the View Choice dialog, then select the 

 

Use View

 

 button.

 

The GNE network window is displayed using the selected view.

 

Note: 

 

You can also select a view from the command line before you start 
GNE. For more information on, see “Logging in and opening an S/DMS 
Network Manager tool” in 

 

S/DMS Network Manager Connectivity

 

, 
323-4001-053.

Go to step 15.

 

3

 

A view can be renamed using the View Choice dialog or the File menu in the 
GNE window.

 

4

 

Select the view in the View Choice dialog and select the

 

 Rename View

 

 
button.

 

The Name the View dialog appears.

 

Go to step 6.

 

5

 

Display the File menu and select the 

 

Rename View

 

 command.

 

The Name the View dialog appears.

 

6

 

Enter the new name of the view in the

 

 

 

Name for this view field.

 

7

 

Select the 

 

OK

 

 button in the Name the View dialog.

 

The GNE network window is displayed using the renamed view.

 

Note: 

 

You can also rename a view from the command line before you start 
GNE. For more information on, see “Logging in and opening an S/DMS 
Network Manager tool” in 

 

S/DMS Network Manager Connectivity

 

, 
323-4001-053.

Go to step 15.

 

8

 

A view can be copied using the View Choice dialog or the File menu.

 

9

 

Select the view in the View Choice dialog, then select the Copy View button.

 

The Name the View dialog appears.

 

10

 

Enter the name of the copied view in the

 

 Name for this view

 

 field.

 

—continued—

 

If 

 

you want to

 

Then 

 

rename a view using the View Choice dialog step 4

rename a view using the File menu step 5

 

If 

 

you want to

 

Then 

 

copy a view using the View Choice dialog step 9

copy a view using the File menu step 12
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Procedure 2-1 (continued)

 

Managing network views

 

Step Action

11

 

Select the 

 

OK

 

 button in the Name the View dialog.

 

The GNE network window is displayed using the copied view.

 

Go to step 15.

 

12

 

Display the File menu and select the 

 

Save

 

 

 

View as 

 

command.

 

The view is copied and does not appear in the View Choice dialog.

 

Go to step 15.

 

13

 

Select the view in the View Choice dialog and select the

 

 Delete View

 

 button.

 

A delete confirmation dialog appears.

 

14

 

Select the 

 

Yes, delete it

 

 button.

 

The view and associated annotations, with the exception of network element 
and ring traffic display link annotations, are deleted. If any GNB users are 
displaying the view when it is deleted in GNE, they are informed the view has 
been deleted. They are also given the option to switch to another view, exit 
the tool, or continue using the deleted view with the warning that all view 
specific annotations have been removed.

 

Note: 

 

It is not possible to delete the last remaining view for a network. If only 
one view remains for the tool, the delete command is disabled (grayed out).

 

15

 

Save the new S/DMS Network Manager configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

 

—end—
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Procedure 2-2

 

Viewing controller status

 

Use this procedure to display the status of the controllers monitored by S/DMS 
Network Manager. The Controller List dialog displays the current status of the 
S/DMS Network Manager alarm collection process, and provides information 
on each controller being monitored by S/DMS Network Manager. Also, you 
can use this dialog to control alarm collection and edit, delete, and login to 
controllers.

 

Note: 

 

If the name of a controller is changed, the name displayed in the 
Controller Details dialog is updated only when the controller is re-added 
to the network configuration. It is not updated dynamically.

Before starting this procedure, read “Requirements” on page 2-1.

 

Action

 

Step Action

1

 

Display the Controllers menu and select the 

 

Show List of Controllers

 

 
command.

 

The Controller List dialog appears.

 

2

 

To control the alarm reporting from a controller, or stop the alarm collection 
process for all controllers that S/DMS Network Manager is monitoring, see 
Procedure 2-18, “Controlling alarm collection”.

To control the alarm reporting from a network element that S/DMS Network 
Manager is monitoring, see Procedure 2-18, “Controlling alarm collection”.

 

3

 

To edit the details of a particular controller, enter a comment about a 
controller, or view the software release installed on each controller, see 
Procedure 2-20, “Viewing and editing the details of a controller”.

 

4

 

Select the 

 

Done

 

 button when you finish with the Controller List dialog.

 

—end—
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Procedure 2-3

 

Adding a group

 

Use this procedure to add a group to the network or subnetwork window. 
Groups represent a user-defined collection of nodes. The nodes within a group 
can include network elements and other groups.

Groups are available in three shapes: rectangle, multipoint line, and polygon.

Groups can be nested within other groups without restriction. A group may 
contain a hierarchy of other groups and network elements, representing a 
network configuration. This feature enables you to design a network composed 
of several levels of detail.

Before starting this procedure, read “Requirements” on page 2-1.

 

Action

 

Step Action

1

 

Select the 

 

Add group

 

 command from the Layout menu.

 

Note: 

 

The Add group command can also be selected from the Background 
menu.

 

The Group Display Attributes dialog appears.

 

2

 

Enter the group name and select the shape style, fill style, and group color.

 

Note 1: 

 

Group names are optional.

 

Note 2: 

 

Fill style cannot be selected for multipoint line groups.

 

3

 

Groups are available in rectangle, multipoint line, and polygon shapes.

 

4

 

Select the 

 

Add Group

 

 button.

 

An outline of the new rectangle group is attached to the mouse cursor. The 
Group Display Attributes dialog is closed.

 

Note: 

 

The outline of the new rectangle group is only visible when the mouse 
cursor is above a network or subnetwork window.

 

5

 

Position the group in an S/DMS Network Manager window by clicking the left 
mouse button. 

Go to step 8.

 

—continued—

 

If 

 

you are adding a new 

 

Then 

 

rectangle group step 4

multipoint line or polygon group step 6
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Procedure 2-3 (continued)

 

Adding a group

 

Step Action

6

 

Select the 

 

Add Group

 

 button.

 

A cross-hair mouse cursor appears. The Group Display Attributes dialog is 
closed.

 

7

 

To define the shape of the new group, the vertices or bend points of the group 
must be specified using the mouse. For each vertex or bend point, position 
the mouse cursor in the desired location and click the left mouse button once. 
To complete the drawing of the group, click on the previous point, 
double-click on the point where you want the group to end, or select the End 
key on the keyboard.

Note 1: The minimum number of end and bend points for multipoint line and 
polygon groups is 2.

Note 2: If you have started to draw a multipoint line or polygon group, 
pressing the ESC key on the keyboard ends the operation without a group 
being added.

8 The position of a group can be changed by clicking and holding the middle 
mouse button on the group, and dragging the group to the new position.

The attributes of existing groups can be edited. For more information, see 
Procedure 2-4, “Editing a group”.

9 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-4
Editing a group

Use this procedure to edit an existing group in the S/DMS Network Manager 
surveillance network.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Display the object menu for the group you want to edit and select the 
Edit <group> command.

Note: The Edit <group> command can also be selected from the Layout 
menu.

The Group Display Attributes dialog appears. Also, highlight handles are 
applied to the vertices and bend points of the group.

2 To change the size or shape of the group, select one of the highlight handles, 
hold the left mouse button, drag the handle to the new location, and release 
the mouse button.

The modified group appears.

The alarm balloon, alarm summary count, and group name may need to be 
repositioned. See step 5.

3 You can add or delete a vertex or bend point for multipoint line and polygon 
groups. To add a vertex or bend point, use the left mouse button to click on a 
line segment between two existing vertices.

A new vertex or bend point is added at the specified point on the line 
segment.

To delete a vertex or bend point, select the highlight handle and press the 
delete key on the keyboard.

The vertex or bend point is removed from the group.

4 The group name, shape type, fill style, and color can be changed by 
specifying the new value in the Group Display Attribute dialog and selecting 
the Apply button.

The group is displayed with the modified attribute. The Group Display 
Attribute dialog remains open, allowing you to continue to make changes to 
the groups.

Note 1: The Apply must be selected before any other changes are made.

—continued—
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Procedure 2-4 (continued)
Editing a group

Step Action

5 The alarm balloon, alarm summary count, and group name for multipoint line 
and polygon groups can be repositioned by selecting any one of these items, 
holding down the left mouse button, and dragging the item to a new location.

Note: The total active alarm summary must be located on the group.

6 Select the Done button in the Group Display Attribute dialog.

The Group Display Attribute dialog closes.

7 If necessary, reposition the remaining groups. See Procedure 2-8, 
“Repositioning a network element or group”.

8 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-5
Deleting a group

Use this procedure to delete a group from the S/DMS Network Manager 
surveillance network. Deleting a group from S/DMS Network Manager has no 
affect on the working system.

S/DMS Network Manager disables (grays out) the Delete <group> command 
if the group contains network elements or other groups, or the group is 
attached to a link.

To enable the Delete <group> command for a group, you must first transfer all 
network elements and groups out of the group you want to delete. Also, you 
must remove any links attached to the group.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Move to the group you want to delete and double-click on it.

The subnetwork window for the group appears.

2 If there are network elements or groups in the subnetwork window, transfer 
them to another group or window. 

For more information on transferring network elements and groups, see 
Procedure 2-8, “Repositioning a network element or group”.

3 Delete the links attached to the group you want to delete, if any.

For more information removing links attached to groups, see Procedure 2-10, 
“Modifying network element connections”.

4 Select the group you want to delete.

5 Display the Layout menu and select the Delete <group> command.

The group is removed from the window.

6 If necessary, reposition the remaining groups. See Procedure 2-8, 
“Repositioning a network element or group”.

7 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-6
Adding a new controller

Use this procedure to add a new controller, and all network elements 
associated with that controller, to S/DMS Network Manager. This procedure 
allows you identify the controllers you want S/DMS Network Manager to 
monitor, and to build a network configuration.

A span is a collection of network elements that use the same controller. When 
you add a span, you establish a connection between S/DMS Network Manager 
and the controller of the network elements. This connection allows S/DMS 
Network Manager to communicate with the controllers, and collect alarm 
information from the network elements. The connection also allows S/DMS 
Network Manager users to log in to the controller.

A controller is added to a system using the Controller Details dialog. The 
controller is added to the window that was active prior to opening this dialog. 
A controller can also be added to a group by selecting it before opening the 
Controller Details dialog.

Note: If the name of a controller is changed, the name displayed in the 
Controller Details dialog is updated only when the controller is re-added 
to the network configuration. It is not updated dynamically.

On some controllers, two types of user interface are available: an X Window 
user interface and a character mode terminal (CMT) user interface. While 
adding a span, you can specify which format to use as the default when a user 
logs in to the controller.

If a controller runs an S/DMS TransportNode OC-48 Rel 11 or 12, or 
OC-3/OC-12 Rel 10 or 11, a bridging operation must be performed on the 
controller to enable the connection management and service assurance 
features. Bridging transfers and updates the S/DMS Network Manager server 
software on the controller. When enabled, bridging is automatically performed 
when the controller is added to the network configuration. No changes are 
made to the controller application software during the bridging operation, and 
bridging has no effect on the performance of the controller. Controllers 
running an earlier software release cannot be bridged.
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Procedure 2-6 (continued)
Adding a new controller

Note: The file transfers involved in software bridging may take some time 
to complete.

Additional Requirements
In addition to the requirements described on page 2-1, the following condition 
must be satisfied to complete this procedure:

• ensure you know the IP addresses of the primary and backup controllers

Action

Step Action

1 Select the window or group where you want to add the new controller.

2 Select the Add a New Controller to <group> command from the Controller 
menu.

Note: You can also select the Add a New Controller to <group> command in 
the group object menu.

3 The Controller Details dialog appears.

There can be two controllers in a span: a primary controller and a backup 
controller. Use the Controller Details dialog to record the IP addresses of 
each of these controllers.

Note: The IP Address field on the right of the dialog is disabled.

4 Enter the IP address of the primary controller in the IP Address field on the 
left side of the dialog. 

Note: The IP address has the form n.n.n.n, where n is a number within the 
range of 0 to 255.

5 Select the Validate button located under the IP Address field.

S/DMS Network Manager attempts to communicate with the entity at the 
specified IP address. If the specified IP address contains a S/DMS 
Network Manager controller, the details of that controller appear below the IP 
Address field. 

If you made an error entering the IP address, or the address is not valid, an 
X appears next to the IP Address field and an error dialog appears.

—continued—

CAUTION
Risk of malfunction
S/DMS Network Manager files include three tar files, 
COPC17BL_..., COPC17BM_..., and COPC17BO_.... 
These files are required any time software bridging is 
performed. Do not delete these files.



2-14   Configuring a network

S/DMS Network Manager    323-4001-054    Rel 6   Standard   Nov 1996

Procedure 2-6 (continued)
Adding a new controller

Step Action

6 To add a secondary controller, select the IP Address field on the right side of 
the dialog, enter the IP address of the controller, and select the Validate 
button.

S/DMS Network Manager attempts to communicate with the entity at the 
specified IP address. 

If the specified IP address contains a controller, details of that controller 
appear below the IP Address field. Otherwise, an X appears next to the IP 
Address field to indicate an error.

Note 1: It is not mandatory to record the IP address of both the primary and 
the backup controller. However, if you record only one IP address, and a 
problem occurs in that controller, S/DMS Network Manager is not able to 
provide alarm information for the network elements in that span.

Note 2: If you record only the IP address of the backup controller, the backup 
controller must be active. S/DMS Network Manager cannot collect alarm 
information from an inactive controller. The primary and backup controllers 
must be associated with the same span. Do not add primary and backup 
controllers from different spans.

Note 3: Use the same Controller Details dialog to add primary and backup 
controllers to the same span.

7 Move to the Login Type area and select the button corresponding to the 
default user interface to be displayed when a user logs in to the controller.

Note 1: If a controller provides only one type of user interface, only the button 
for that user interface is enabled; the other button is disabled (grayed out).

Note 2: If you select the Display X Windows Session as the default user 
interface, users can override the default and display a character session user 
interface when they log in to the controller. If you select Display character 
session as the default, users cannot override the default. 

8 Controllers running OC-48 Rel 11 or 12, or OC-3/OC-12 Rel 10 or 11 software 
release must be bridged before the connection management and service 
assurance features can be used. Controllers running an earlier software 
release cannot be bridged.

If the controller you are adding runs an OC-48 Rel 11 or 12, or an 
OC-3/OC-12 Rel 10 or 11 software release, the Bridging buttons are 
activated. By default, the Disable button is selected. To enable bridging of the 
controller, select the Enable button. 

Note: Bridging is performed only when the new S/DMS Network Manager 
configuration is saved. The file transfers involved in software bridging may 
take some time to complete.

—continued—
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Procedure 2-6 (continued)
Adding a new controller

Step Action

9 Move to the Controller Comments field, and enter a comment for the 
controller.

Note: You can enter any comment up to 40 characters in length, in this field. 
Controller comments are optional, but are used to provide additional 
information about a controller. 

10 The buttons at the bottom of the Controller Details dialog allow you to add a 
single new controller or a number of new controllers.

11 Select the OK button in the Controller Details dialog.

The Controller Details closes, and the network elements associated with the 
new controller appear at the specified location.

Go to step 14.

12 Select the Apply button.

The network elements associated with the new controller appear in the 
specified window. The Controller Details dialog remains on the screen 
allowing you to continue adding new controllers.

Go to step 4.

13 Select the Cancel button to remove the Controller Details dialog.

14 The network elements are placed at the bottom of the window in the specified 
location. To move the network elements to a new position, see 
Procedure 2-8, “Repositioning a network element or group”.

15 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—

If you want to Then 

add only one new controller step 11

add multiple new controllers step 12

cancel the operation step 13
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Procedure 2-7
Deleting a controller

Use this procedure to delete a controller from the S/DMS Network Manager 
surveillance network. Deleting a controller from S/DMS Network Manager 
has no affect on the working system. 

This procedure removes the controller entry in the Controller List dialog. The 
communication link between S/DMS Network Manager and the controller is 
dropped and S/DMS Network Manager is no longer able to collect alarms from 
that controller.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Display the Controllers menu and select the Show List of Controllers 
command.

The Controller List dialog appears.

2 Select the controller you want to delete and display the Controller List dialog 
list menu.

The controller information is highlighted and the Controller List dialog list 
menu appears.

3 Select the Delete command.

A delete confirmation dialog appears.

4 Select the Yes button in the Delete Confirmation dialog to confirm the 
deletion.

The network elements associated with the controller are removed from the 
network configuration.

5 If necessary, reposition the remaining groups. See Procedure 2-8, 
“Repositioning a network element or group”.

6 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—

CAUTION
Make sure that this controller is the one you want to 
delete before confirming the deletion.
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Procedure 2-8
Repositioning a network element or group

Use this procedure to transfer network elements and groups between windows, 
and move network elements and groups within their current window.

This procedure allows you to build a customized surveillance network that 
contains a user-defined arrangement of network elements and groups. It is not 
necessary for the network elements in the same span to be located in the same 
group.

Note: The configuration you create by transferring network elements and 
groups has no affect on the working system.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Activate the Display NE numbers, Display Names and Display 
Highlighting commands in the Options menu to assist in the placement of 
the network elements and groups.

A number, name, and highlighting appear on each network element and 
group.

Note: Network element display size can change when you select the Display 
Highlighting command. For more information on the display size of network 
elements, see Procedure 2-14, “Changing the network element icon display 
size”.

2 If required, open the subnetwork window containing the group or network 
element you want to move or transfer.

The subnetwork window for the selected group appears.

Note: You must open multiple subnetwork windows if the group is located in 
a nested hierarchy.

3 If you are transferring a network element or group, ensure that the 
subnetwork window receiving the nodes is open.

4 Move the pointer over the network element or group you want to move or 
transfer and hold down the middle mouse button.

—continued—
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Procedure 2-8 (continued)
Repositioning a network element or group

Step Action

5 Drag the pointer to the position you want the network element or group to 
appear.

A ghost image of the selected group or network element moves with the 
pointer to show the new position.

You can move the network element or group within the current window, or 
transfer them to a window already open on the screen.

Note: Ensure that you do not violate group hierarchies when moving groups. 
S/DMS Network Manager indicates if the transfer of a group results in 
incorrect nesting.

6 Release the mouse button once you are satisfied with the position of the 
group or network element.

The group or network element appears in its new position.

If any links are attached to the network element that you are moving or 
transferring, the links are automatically redrawn. Links to other windows are 
identified by a link continuation icon on the end of the link.

NM-10624.1

7 The alarm balloon, alarm summary count, and group name may need to be 
repositioned if group displays overlap. For more information, see 
Procedure 2-4, “Editing a group”.

8 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-9
Connecting groups and network elements

Use this procedure to add connections between groups or network elements. 
These connections are called links. Three types of links are used by S/DMS 
Network Manager: fiber, electrical, and control network (CNet). 

This procedure allows you to connect groups and network elements, creating 
a representation of the connectivity in the system. Groups or network elements 
can be connected within the same window, or to a group or network element 
in a different window.

Note: Links cannot be added between groups and network elements. If you 
attempt to connect a group to a network element, a warning beep sounds.

If your S/DMS Network Manager monitors a system that contains a TA-1230 
ring, GNE automatically creates a graphical representation of the ring.

Note: The link types described in this procedure are suggestions only. You 
can connect the groups and network elements in any manner you like. 
Connecting the groups and network elements on GNE has no effect on the 
configuration of the system. The links in GNE are used only as a graphical 
representation of group and network element connectivity in the working 
system. To perform STS connection provisioning operations, see 
“Provisioning and editing connections” in S/DMS Network Manager 
Connection Management, 323-4001-057.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Display the window(s) containing the network elements or groups you want to 
connect.

2 Display the background menu and select the Add Link command.

Note: These commands are also available in the Layout menu of the network 
and subnetwork windows.

The Connect Network Elements dialog appears.

3 Select the radio button that corresponds to the type of link you want to use to 
connect the groups or network elements.

—continued—



2-20   Configuring a network

S/DMS Network Manager    323-4001-054    Rel 6   Standard   Nov 1996

Procedure 2-9 (continued)
Connecting groups and network elements

Step Action

4 Move the pointer to the window containing the first group or network element 
you want to connect.

The pointer changes to the shape of a hand to indicate that GNE is in the 
connect mode.

5 Select the first group or network element in the link.

The border color of the selected group or network element changes color to 
remind you which group or network element that you are connecting. The 
hand pointer changes direction to indicate that you still have to pick another 
group or network element.

6 Select the second group or network element in the link.

Note: You must select a pair of groups or network elements to create a link. 
You can select groups and network elements located in different windows. If 
you do so, GNE places a link continuation icon at the end of the link in each 
window.

A link appears between the two selected groups or network elements and the 
border is removed from the first group or network element. The pointer 
changes to the initial hand shape.

Note:  If you attempt to connect a group to a network element, a warning 
beep sounds, and no link is created.

7 The Connect Network Element dialog remains on the screen. To continue 
adding links, go to step 3.

When you finish connecting groups or network elements, select the OK 
button to close the Connect Network Element dialog.

Note: You can add as many links to a group or network element as you like. 
However, the links become increasingly more difficult to distinguish as the 
number of links increases.

8 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-10
Modifying network element connections

Use this procedure to modify the links between network elements. This 
procedure allows you to change a link type or delete a link.

If your S/DMS Network Manager monitors a system that contains a TA-1230 
ring, and a representation of that ring is displayed on your S/DMS Network 
Manager, you can modify the ring configuration. To modify the ring 
configuration, see Procedure 2-13, “Adding or deleting regenerators on a ring 
configuration”. 

Note: The link types described in this procedure are suggestions only. The 
network element links shown on GNE have no effect on the configuration 
of the system. They are used only as a graphical representation of network 
element connectivity in the working system. To add connections between 
network elements, see Procedure 2-9, “Connecting groups and network 
elements”.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 If necessary, display the subnetwork window containing the link you want to 
modify by double-clicking on its group. 

A separate subnetwork window appears for each group selected.

Note: If a link continuation icon appears at the end of the link, and you want 
to see which network elements are on this link, double-click on the icon to 
display the window containing the remainder of the link.

2 Select the link you want to modify and display the object menu.

The link is highlighted and the object menu appears.

3 You can change the link type, or you can delete the link.

4 Move the pointer to the Change <link> to command in the object menu.

A cascade menu appears.
—continued—

If you want to Then 

change the link type step 4

delete the link step 6
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Procedure 2-10 (continued)
Modifying network element connections

Step Action

5 Select the desired link type from the Change <link> to cascade menu.

The link changes to whatever type of link you select. The menu and highlight 
are removed from the link.

Go to step 7.

6 Select the Delete <link> command from the object menu.

The selected link disappears.

Note: The Change <link> to and Delete <link> commands can also be 
initiated using the Layout menu in the network and subnetwork window.

7 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-11
Displaying link continuations

Use this procedure to display network elements that are linked together, but 
located in different windows. 

S/DMS Network Manager uses a link continuation icon to identify network 
element links that span two or more windows. The link continuation icon is a 
pointer located at the end of a link. The icon indicates that this link continues 
into another window. 

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Move to a window containing a link continuation icon.

The link continuation icon is the diamond shaped icon at the end of a link.

2 Double-click on the link continuation icon.

A second subnetwork window appears. This window contains the remainder 
of the network elements in the selected link. The link continuation is 
highlighted by a related link icon.

NM-10625.1

—end—
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Procedure 2-12
Arranging link continuation icons

Use this procedure to move the link continuation icons. These icons identify 
links that continue in another window.

Link continuation icons can be moved anywhere within their current window.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Double-click on the group that contains the link whose continuation icon you 
want to move. 

A separate subnetwork window appears for each group selected.

2 Move the pointer over the link continuation icon you want to move, hold down 
the middle mouse button, and drag the pointer to the position where you want 
the link continuation icon to appear.

A ghost image of the selected icon moves with the pointer to show the new 
position.

3 Release the mouse button once you are satisfied with the position of the link 
continuation icon.

Note: You cannot move link continuation icons outside their current window.

The link continuation icon appears in its new position.

4 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-13
Adding or deleting regenerators on a ring 
configuration

Use this procedure to add or delete regenerators to the traffic display link 
between adjacent ADMs in a TA-1230 ring configuration.

When a regenerator is added, this procedure allows you to build up a true 
representation of the TA-1230 ring so that GNB users can monitor the ring 
traffic, alarms, and protection status.

Note: Use this procedure only if your S/DMS Network Manager monitors 
a system that contains a TA-1230 ring.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 To add or delete a regenerator, select the appropriate traffic display link.

The traffic display link is highlighted.

2 Display the Layout menu and select the Attach Regens to <Traffic Link> 
command.

The Configure Regenerators dialog appears.
NM-10268.1

Note: The Attach Regens to <Traffic Link> command is disabled if a TA-1230 
ring is not currently displayed on GNE.

3

—continued—

If  you are Then 

adding a regenerator step 4

deleting a regenerator step 8

NM-10268.1

Use this command to add regenerators between two ring ADMs



To add one or more regenerators:

1. Click on the first Ring ADM.

2. Click on one or more regenerators.

3. Click on the second Ring ADM.



When done, click on the OK button.

OK              Alt+Return  Cancel           Ctrl+Escape
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Procedure 2-13 (continued)
Adding or deleting regenerators on a ring configuration

Step Action

4 Move to the window that contains the first of the adjacent ADMs that you want 
to add a regenerator between, and click on the ADM.

The selected ADM is highlighted.

5 Move to the window that contains the regenerator you want to connect to the 
ADM and click on it.

A traffic display link is added between the first ADM and the regenerator.

Note: If the ADMs and regenerators are located in different windows, a link 
continuation icon is added at the end of the ring traffic display link in each 
window.

6 Continue selecting the regenerators that are part of the link between the 
adjacent ADMs in the ring.

When you select a regenerator, a ring traffic display link appears on the 
regenerator. Any previous links, for example fiber links, are replaced by the 
ring traffic display link.

Note: Select only the regenerators that are actually used in the ring. S/DMS 
Network Manager does not verify that the selected regenerators are part of 
the ring configuration. If you select any object other than a regenerator, a 
beep sounds.

7 After you select the last regenerator, move to the second of the adjacent 
ADMs and click on it.

Note: The adjacent ADMs in a ring are a matched pair. Make sure you select 
the appropriate ADM when completing the line configuration. If you select the 
wrong ADM, a beep sounds.

The original ring traffic link between the adjacent ADMs is removed, and a 
new ring traffic link is routed through the regenerators to the ADMs.

—continued—
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Procedure 2-13 (continued)
Adding or deleting regenerators on a ring configuration

Step Action

NM-10626.1

Go to step 10

8 Move to the first ADM on the link and click on it.

The selected ADM is highlighted.

9 Move to the second ADM on the same link and click on it.

The direct traffic link between the two ADMs is established. The regenerators 
are removed from the traffic display link.

10 You can cancel the changes you made to the ring configuration, continue 
adding regenerators between the other ADMs in the ring, or you can end the 
regenerator configuration.

11 Select the OK button to implement the changes you made to the ring 
configuration.

The Configure Regenerators dialog is removed.

Go to step 13.

—continued—

If  you want to Then 

add or delete regenerators step 1

end the regenerator configuration step 11

cancel the changes made to the ring configuration step 12
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Procedure 2-13 (continued)
Adding or deleting regenerators on a ring configuration

Step Action

12 Select the Cancel button in the Configure Regenerators dialog.

The Configure Regenerators dialog is removed from the display. Any 
regenerators you added between adjacent ADMs are removed.

The Configure Regenerators dialog is removed from the display. 

13 When you finish configuring the regenerators, save the new S/DMS Network 
Manager configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-14
Changing the network element icon display size

Use this procedure to change the size designation of icons used to represent 
network elements on the S/DMS Network Manager screen.

S/DMS Network Manager can display network elements using three size 
designations: small, variable, or large. When you use the Preferences dialog to 
change the network element size designation, the network elements in all 
windows change to the selected size. The network element size designation set 
in the GNE Preferences dialog becomes the default value for the GNB. 
However, the GNB can be used to override the default display preferences set 
in the GNE.

For more information on network elements and the information associated 
with the icon display size, see “Understanding GNB” in S/DMS Network 
Manager Fault Management, 323-4001-055.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Display the Options menu and select the Set Preferences command.

The Preferences dialog appears.

2 Select the network element size designation using the NE Size radio buttons.

3 Select the OK button.

The network elements change to the selected size designation in the GNE 
session.

4 When you finish making changes, save the new S/DMS Network Manager 
configuration.

The network element size specified in the Preferences dialog becomes the 
default display for that view in the GNB.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-15
Controlling the display of the name or number of an 
object

Use this procedure to control the display of group names and network element 
names and numbers. You can display or hide the name and number of network 
elements. Also, you can control the font size and background color used to 
display group names and network element names and numbers.

Note: The name and number of a network element cannot be hidden if the 
network element has an active alarm.

If the names and numbers for a network element are hidden, they are 
redisplayed when a new alarm is raised on the network element.

Display preferences set in the GNE become the defaults for the GNB. The 
GNB user can reset the default display preferences, if necessary.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 When you first start GNE, the group and network element names and the 
network element numbers are shown. 

Note: A check mark next to a command indicates the command is active. 
When a command is active, the display option specified is implemented for 
the selected window range.

—continued—

If you want to Then 

display or hide the names or numbers for the 
network elements in an individual window

step 2

display or hide the names or numbers for the 
network elements in all windows

step 3

set the font size for group names and network 
element names and numbers

step 6

set the background color for group names and 
network element names and numbers

step 9
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Procedure 2-15 (continued)
Controlling the display of the name or number of an object

Step Action

2 Display the Options menu in the desired window and select the Display NE 
Names or the Display NE Numbers command.

The names or numbers for network elements are displayed or removed from 
the specified window.

Go to step 11.

3 Display the Options menu and select the Set Preferences command.

The Preferences dialog appears.

4 Select the NE Names or the NE Numbers check button.

5 Select the OK button.

The names or numbers for all network elements are displayed or removed.

Go to step 11.

6 Display the Options menu and select the Set Preferences command.

The Preferences dialog appears.

7 Select the font size using the NE Font Size and the Group Font Size radio 
buttons.

Note: The font size setting is independent of the network element size. 
However, if the font size is set to variable, the font changes in response to the 
network element activity.

8 Select the OK button.

The font size is changed in all windows.

Go to step 11.

9 Display the Options menu and select the Set Preferences command.

The Preferences dialog appears.

10 Select Group Names Background or the NE Names Background check 
buttons.

The background color for group names and network element names and 
numbers is changed to grey.

11 Display preferences set using the Preferences dialog replace the display 
preferences set using the check commands in the Options menu.

—end—
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Procedure 2-16
Attaching, editing, and deleting annotations

Use this procedure to attach several lines of text to a network element, group, 
or link. You can also use the procedure to edit or delete existing annotations.

The Annotations dialog contains the name of the object selected and an edit 
field with a background menu and cut and paste capabilities. A scroll bar in the 
dialog enables you to view the entire annotation.

Annotations attached to an object in GNE are visible in GNB when the 
Annotations dialog for the object is displayed.

Note: If there are multiple links of the same type (fiber, electrical, or CNet) 
between two groups or two network elements, the annotations are the same 
for each link.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Select the desired network element, group, or link. 

2 Display the File menu and select the Edit Annotations command.

The Annotations dialog appears.

Note: You can also display the Annotations dialog by displaying the object 
menu and selecting the Edit Annotations command, or by holding down the 
Shift key while clicking on the object.

3 Enter the annotation text in the text field and select the OK button.

The annotation is attached or modified for the selected object.

Go to step 5.

4 Display the File menu and select the Delete Annotations command.

The annotations are deleted for the selected object.

Note: The Delete Annotations command is enabled only after the new or 
edited annotations are saved as part of an S/DMS Network Manager 
configuration. To save the configuration display the File menu and select the 
Save command.

5 You have completed this procedure.

—end—

If you want to Then 

attach or edit an annotation step 2

delete an annotation step 4
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Procedure 2-17
Managing background maps

Use this procedure to load, scale, position, and display background maps.

Background maps can be displayed for an individual window, or set for all 
windows in the session.

Note: The display preferences set in the GNE become the defaults for the 
GNB. The GNB user can reset the default display preferences, if desired.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 When you first start GNE, background maps are not shown in the network 
and subnetwork windows. 

Note: A check mark next to a command indicates the command is active. 
When a command is active, the display option specified is implemented for 
the selected window range.

2 Display the Options menu and select the Load Background Map command.

The Load Map dialog appears.

File type buttons enable you to limit the files displayed for the current 
directory. Map files supported by S/DMS Network Manager are vector-based 
(DXF format) and image-based (GIF format). 

The Directory field indicates the current directory. The contents of the 
directory are displayed in the Filename list. The field also has a chooser menu 
that enables you to select a directory from previously used paths.

3 Select a directory in the Filename list by double-clicking on the directory 

The contents of the selected directory is displayed in the Filename list.
—continued—

If you want to Then 

load a background map step 2

position and scale a background map step 5

display or hide a background map for an individual 
window

step 8

display or hide a background map for all windows step 9
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Procedure 2-17 (continued)
Managing background maps

Step Action

4 Choose a map file and select the OK button.

Note: A map file can also be selected and implemented in a window by 
double-clicking on the file in the Filename list.

The map file is loaded into the selected window. The Map Tools palette 
automatically appears after a map is successfully loaded into a window.

The user is notified if the specified directory or filename is invalid.

Note: A background map can be removed from a window by selecting the 
Unload map button.

Go to step 6.

5 Open Map Tools palette by displaying the Options menu and selecting the 
Display Map Tools command.

The Map Tools palette appears.

Note: The Display Map Tools command is active only if a background map is 
displayed in the selected window.

6 Position and scale the map using the buttons in the Map Tools palette. For 
more information, see “Background maps” on page 1-20.

Note: The position of all background maps can be modified. However, only 
the scale of a vector-based map (DXF format) can be modified. It is not 
possible to modify the scale of an image-based map (GIF format).

7 Display the File menu in the Map Tools palette window and select the Close 
commands.

Go to step 13.

8 Display the Options menu in the desired window and select the Display 
Background Map command.

If a check mark appears beside the Display Background Map command, the 
background map is displayed in the selected window.

Go to step 13.

9 Display the Options menu and select the Set Preferences command.

The Preferences dialog appears.

10 Select the Background Maps command.

A check mark indicates that the command is active.

11 Select the OK button.

If the Background Maps command is active in the Preferences dialog, 
background maps in all windows are displayed.

Note: The display preferences set using the Preferences dialog replace the 
display preferences set using the check commands in the Options menu.

—continued—



Configuring a network   2-35

Configuration   323-4001-054   Rel 6   Standard   Nov 1996

Procedure 2-17 (continued)
Managing background maps

Step Action

12 When you finish making changes, save the new S/DMS Network Manager 
configuration.

For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

13 You have completed this procedure.

—end—
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Procedure 2-18
Controlling alarm collection

Use this procedure to stop or start the S/DMS Network Manager alarm 
collection process.

If you stop the alarm collection process, S/DMS Network Manager is unable 
to communicate with any controllers in the network. Alarms are not collected 
from any controllers. 

The alarm counts and traffic display information shown on GNB become 
unreliable because S/DMS Network Manager does not collect any new alarms 
from the controllers it monitors.

When you restart the alarm collection process, S/DMS Network Manager 
resumes communication with the controllers. The alarm counts and traffic 
display information shown on GNB is updated.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Display the Controllers menu and select the Show List of Controllers 
command.

The Controller List dialog appears.

2 The button beside the Collection Status field allows you to control the S/DMS 
Network Manager alarm collection process. The label inside this button 
toggles between Stop and Start, each time you select it. The label shows the 
action you can take.

Note: When you stop the alarm collection, S/DMS Network Manager stops 
monitoring all controllers. All communications between S/DMS Network 
Manager and the controllers also stops.

—continued—

If you want to Then 

stop the alarm collection step 3

start the alarm collection step 5
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Procedure 2-18 (continued)
Controlling alarm collection

Step Action

3 Select the Stop button. 

A confirmation dialog appears.

Note: If you make changes to the configuration, you are prompted to save the 
changes before S/DMS Network Manager will allow you to stop the alarm 
collection. For more information, see Procedure 2-21, “Saving or reverting 
the configuration”.

4 Select the Yes button in the confirmation dialog to stop the S/DMS Network 
Manager alarm collection process. 

To indicate that communication between S/DMS Network Manager and all 
controllers has been stopped, the S/DMS Network Manager Collection status 
field changes to Stopped. All group and network element nodes change to 
blue, and the network window status icon changes to a red X.

Go to step 6.

5 Select the Start button. 

S/DMS Network Manager attempts to restart its collection process. During 
this time, S/DMS Network Manager reestablishes communication with each 
controller.

As communication is reestablished, the group and network element nodes 
change from blue to gray. Once S/DMS Network Manager can communicate 
with all controllers, and there are no problems, the status icon changes back 
to a green check mark.

6 When you finish with the Controller List dialog, select the Done button.

—end—
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Procedure 2-19
Controlling alarm reporting

Use this procedure to suspend or resume alarm reporting for an individual 
network element, or all network elements associated with a controller. When 
alarm reporting is suspended, S/DMS Network Manager continues to collect 
alarms from the network elements. All alarms raised by the network elements 
appear in the GNB when alarm reporting is resumed.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Alarm reporting can be suspended for an individual network element or all 
network elements associated with a controller.

2 Select the network element for which you want to suspend alarms.

3 Display the object menu for the network element and select the Suspend 
Reporting for <ne> command. 

Note: This command is also available in the Fault menu.

Alarm reporting is suspended for the selected network element. A not 
reporting notation (NR) appears inside the network element.

The network window status icon changes to an inverted yellow triangle.

Go to step 11.

4 Select the network element for which you want to resume alarms.

—continued—

If you want to Then 

suspend alarm reporting for an individual network 
element

step 2

resume alarm reporting for an individual network 
element

step 4

control alarm reporting for all network elements 
associated with a controller

step 6
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Procedure 2-19 (continued)
Controlling alarm reporting

Step Action

5 Display the object menu for the network element and select the Resume 
Reporting for <ne> command.

Note: This command is also available in the Fault menu.

Alarm reporting from the selected network element resumes. The not 
reporting (NR) notation is removed from inside the network element. Alarms 
recorded by the network element during the time that the reporting was 
suspended are displayed on GNB.

If the network window status icon remains an inverted yellow triangle after 
you resume alarm reporting for a network element, there is another network 
element for which alarm reporting is suspended. Resume alarm reporting for 
that network element if desired.

Go to step 11.

6 Display the Controllers menu and select the Show List of Controllers 
command.

The Controller List dialog appears.

7 Select the controller whose alarm reporting you want to suspend or resume, 
and display the Controller List dialog list menu.

The Controller List dialog list menu appears.

8 The Controller List dialog list menu contains a command that allows you to 
suspend and resume the alarm reporting for the selected controller. This 
command toggles between Suspend all NE Reporting for <controller> and 
Resume all NE Reporting for <controller>, each time you select it. The 
command shows the action you can take on the selected controller.

—continued—

If you want to Then 

suspend alarm reporting for the selected controller step 9

resume alarm reporting for the selected controller step 10
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Procedure 2-19 (continued)
Controlling alarm reporting

Step Action

9 Select the Suspend all NE Reporting for <controller> command.

Note 1: You cannot suspend alarm reporting for a network element if the 
S/DMS Network Manager alarm collection process has been stopped. For 
more information, see Procedure 2-18, “Controlling alarm collection”.

Note 2:  Controllers that have suspended alarm reporting are shown at the 
top of the Controller List dialog list. 

An inverted triangle appears in the column on the far left of the Controller List 
dialog beside the controller name. The Status field for the controller changes 
to Suspended indicating alarms are not being reported on GNB for this 
controller.

The network window status icon changes to an inverted yellow triangle.

A not reporting notation (NR) appears inside the network elements reporting 
to the selected controller.

Go to step 11.

10 Select the Resume all NE Reporting for <controller> command. 

Alarm reporting from the selected controller resumes. Alarms recorded by the 
controller during the time that the reporting was suspended are displayed on 
GNB.

The inverted triangle is removed from the controller entry in the Status list, 
and the status icon in the network window changes back to a green check 
mark if alarm reporting is operating for all other controllers.

If the network window status icon remains an inverted yellow triangle after 
you resume alarm reporting for a controller, there is another controller for 
which alarm reporting is suspended. Resume alarm reporting for that 
controller if desired.

The not reporting (NR) notation is removed from the network elements 
reporting to the selected controller.

11 When you finish with the Controller List dialog, select the Done button.

—end—
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Procedure 2-20
Viewing and editing the details of a controller

Use this procedure to view and, if necessary, edit the details of the controllers 
that S/DMS Network Manager monitors. The Controller List dialog provides 
detailed information about the status of each controller. The Controller List 
dialog enables you to determine the state of the S/DMS Network Manager 
alarm collection process and the alarm reporting from individual controllers.

The Controller List dialog can also be used to view the comments that other 
users have entered for a controller, to determine the software release installed 
on each controller monitored by S/DMS Network Manager, and to view the 
bridging status of a controller.

Note: The Bridging Status button is not used for TL1 MOA controllers.

By editing the details of a controller, you can add a controller, change the IP 
address of a controller, record a comment for the controller, or enable bridging 
of the controller.

On some controllers, two types of user interface are available: an X Window 
user interface and a character mode terminal (CMT) user interface. This 
procedure allows you to select one of these formats as the default user interface 
for a controller. The default user interface is displayed when a user logs in to 
the controller.

Additional Requirements
In addition to the requirements described on page 2-1, the following condition 
must be satisfied to complete this procedure:

• ensure you know the IP addresses of the controllers you are adding

Action

Step Action

1 Display the Controllers menu and select the Show List of Controllers 
command.

The Controller List dialog appears. The dialog lists each controller monitored 
by S/DMS Network Manager.

—continued—
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Procedure 2-20 (continued)
Viewing and editing the details of a controller

Step Action

2 The Controller List dialog enables you to view the status of each controller, 
comments entered by GNE users about a controller, the software release 
installed on a controller, or the software bridging status of a controller. You can 
also use the Controller List dialog to view or edit the details of a particular 
controller.

3 Select the Display Controller Status button.

The Controller List dialog shows the activity and status of each controller.

The Collection Status field shows the current status of the S/DMS Network 
Manager alarm collection process. The possible values are Running and 
Stopped.

The Status column shows the current status of alarm reporting for each 
controller that S/DMS Network Manager monitors.

Go to step 2.

4 Select the Display Controller Comments radio button.

The Controller List dialog displays the comments entered for each controller.

Go to step 2.

5 Select the Display S/W Releases radio button.

The Controller list displays the software releases installed on each controller.

Go to step 2.

6 Select the Bridging Status radio button.

The Controller list displays the controller server software bridging status for 
each controller.

Go to step 2.

7 Select the controller whose details or comments you want to view or edit and 
display the Controller List dialog list menu.

The Controller List dialog list menu appears.

8 Select the Edit command.

The Controller Details dialog appears. The right side of the dialog is marked 
as n/a (not applicable.

—continued—

If you want to Then 

view the status of a controller step 3

view the comments for a controller step 4

view information about the software releases 
installed on a controller

step 5

view the software bridging status of a controller step 6

view or edit controller details step 7
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Procedure 2-20 (continued)
Viewing and editing the details of a controller

Step Action

9 You can edit the details of a controller (change the IP address) or edit a 
comment about the controller, or enable bridging on certain controllers. 

10 If you are only viewing the details of the controller, and you do not want to 
make changes, select the Cancel button to close the Controller Details 
dialog, then select the Done button to close the Controller List dialog.

Go to step 15.

11

To change the IP address of the controller, move the pointer to the IP Address 
field, and edit the field as required.

Note: Do not edit the IP address if you want S/DMS Network Manager to 
monitor a different controller. Instead, delete the controller if necessary, then 
add the other controller.

12 Select the Validate button located under each IP Address field.

S/DMS Network Manager attempts to communicate with the entity at the 
specified IP address. 

If the specified IP address contains a controller, details of that controller 
appear. Otherwise, an X appears next to the IP Address field to indicate an 
error. A message dialog explaining the error appears.

If the error message appears, check that the IP address is correct.

When validation is successful, the Controller List dialog updates with the 
details of the new controllers.

Go to step 14.

—continued—

If you want to Then 

close the Controller Details dialog step 10

change the IP address of the controller step 11

edit the controller comment step 13

CAUTION
Risk of losing configuration data
Change the IP address of a controller only after the 
controller is replaced by a new controller. 

The new controller must control the same span of 
network elements as the old controller, otherwise the 
configuration data for the span may be lost.



2-44   Configuring a network

S/DMS Network Manager    323-4001-054    Rel 6   Standard   Nov 1996

Procedure 2-20 (continued)
Viewing and editing the details of a controller

Step Action

13 Move to the Controller Comments field, and enter or edit the comment for the 
selected controller.

Note: You can enter any comment up to 40 characters in length. Controller 
comments are optional, but are used to provide additional information about 
a controller. If there are no comments for a controller, the Controller 
Comments field for that controller is blank. 

14 Select the OK button in the Controller Details dialog.

The Controller Details dialog is removed.

15 When you finish making changes, save the new S/DMS Network Manager 
configuration.

16 For more information, see Procedure 2-21, “Saving or reverting the 
configuration”.

—end—
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Procedure 2-21
Saving or reverting the configuration

Use this procedure to save changes to the network configuration, or to revert 
back to the last saved configuration.

All changes to the network configuration during the current session are visible 
on the GNE as soon as you make them. The changes are not recorded in the 
database or implemented on the GNB until you save the configuration. 

The GNB screens are updated each time you save the GNE configuration. 
Avoid frequent saves because each save causes the GNB screens to update, 
which can be distracting to network surveillance personnel. 

You may decide not to implement changes you made to the network 
configuration. The revert option allows you to discard all changes made since 
you last saved the configuration, or since you started the current session, 
whichever is more recent.

If you exit GNE before saving, you are prompted to either save or discard your 
changes before exiting GNE. If this dialog appears, see “Exiting GNE” in 
S/DMS Network Manager Connectivity, 323-4001-053.

Before starting this procedure, read “Requirements” on page 2-1.

Action

Step Action

1 Display the network window File menu.

The File menu appears.

2 You can save the changes to the configuration or you can revert to the 
configuration that was last saved.

—continued—

If you want to Then 

save the configuration step 3

revert to the configuration that was last saved step 4
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Procedure 2-21 (continued)
Saving or reverting the configuration

Step Action

3 Select the Save command.

The configuration database and the network shown on GNB are immediately 
updated. This configuration becomes the default configuration. Until you 
make further changes, and save them, this configuration is used by GNE and 
GNB each time that the tool is started.

Go to step 6.

4 Select the Revert command.

A dialog appears asking you to confirm that you want to revert to the last 
saved configuration. 

5 Select the Yes button.

The last saved configuration appears in the window.

6 You can now continue using GNE or exit the tool.

—end—
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ABM

 

Access Bandwidth Manager

 

ADM

 

add-drop multiplexer

 

alarm

 

a condition, such as a fault, that sends a signal to an indicator

 

AN

 

S/DMS AccessNode

 

ASCII

 

American Standard Code for Information Interchange

 

balloon

 

a balloon-shaped object that appears on a node to indicate alarm counts 

 

BLSR

 

bidirectional line switched ring

 

CCITT

 

Consultative Committee on International Telegraphy and Telephony

 

CLFI

 

Common Language Facility Identifier

 

CMT

 

character-mode terminal

 

CNet

 

control network

 

CPC

 

corporate product code
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CPG

 

circuit pack group

 

CSM

 

centralized software management

 

DARPA

 

Defense Advanced Research Projects Agency

 

DDS

 

digital data storage (tape)

 

DMS

 

Digital Multiplex System

 

DMS MAP

 

Digital Multiplex System Maintenance Access Position

 

DV45

 

Digital Video Codec

 

EDA

 

external device access

 

ftp

 

file transfer protocol

 

GNB

 

Graphical Network Browser

 

GNE

 

Graphical Network Editor

 

group

 

a logical collection of network elements

 

GUI

 

Graphical User Interface

 

highlighting

 

the graphical application of color to a node to indicate a certain alarm severity

 

HP

 

Hewlett-Packard

 

HP VUE

 

Hewlett-Packard Visual User Environment
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indicator

 

an audible or visible alert to an alarm or status condition

 

ISO

 

International Standards Organization

 

LAN

 

local area network

 

log in

 

the action of opening a user interface element

 

log out

 

the action of closing a user interface element

 

LTE

 

line terminating equipment

 

MAPCI

 

Maintenance and Administration Position Command Interpreter

 

menu

 

a list of action options

 

menu bar

 

the portion of the graphical user interface that contains the status indicator, and 
the window menus

 

MOA

 

Managed Object Agent

 

network element (NE)

 

a collection of equipment at one location that functions and is administered as 
a single entity

 

node

 

graphic object representing groups or single network elements

 

NTP

 

Northern Telecom Publication

 

NUM

 

Network Upgrade Manager, an OPC tool

 

OAM&P

 

operations, administration, maintenance, and provisioning
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OC-3

 

optical signal carrier level 3 (at 155.520 Mb/s)

 

OC-12

 

optical signal carrier level 12 (at 622.080 Mb/s)

 

OC-48

 

optical signal carrier 48 (at 2488 Mb/s)

 

OC-192

 

optical signal carrier 192 (at 9953.280 Mb/s)

 

OPC

 

operations controller

 

OSI

 

Open Systems Interconnect

 

PEC

 

product engineering code

 

PM

 

performance monitoring

 

SAM

 

System Administration Manager

 

S/DMS

 

Synchronous/Digital Multiplexing System

 

SOC

 

span of control

 

SONET

 

Synchronous Optical Network is a standard for optical transport that defines 
optical carrier levels and their electrical equivalent for synchronous transport 
signals. The SONET standard allows for a multivendor environment, 
positioning the network to transport new services, synchronous networking, 
and enhanced operations, administration, maintenance and provisioning 
(OAM&P).

 

span

 

all network elements under the control of a single operations controller (OPC)

 

STS-1

 

Synchronous Transport Signal (at 51.84 Mb/s)
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subnetwork

 

a graphical collection of objects organized into groups to represent the network 
elements monitored by S/DMS Network Manager.

 

system

 

network elements associated with the same payload

 

TA-1230 ring

 

Bellcore standard for SONET BLSR Equipment Criteria, TA-NWT-001230 
(issue 2)

 

TCP/IP

 

Transmission Control Protocol/Internet Protocol

 

UDLC

 

Universal Digital Loop Carrier

 

UI

 

user interface

 

USM

 

User Session Manager

 

VTBM

 

Virtual Tributary Bandwidth Management

 

window

 

a rectangular area of a display screen used to contain a particular application

 

WAN

 

wide area network

 

X.25

 

CCITT protocol used for wide-area packet switching. OSI Data 
communication standard
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Alarm balloon
GNE   1-17

Alarm collection
controlling   1-24, 2-6, 2-36
status   1-23

Alarm counts
collection stopped   2-36
reporting suspended   1-27

Alarm reporting
suspend/resume   2-38

Annotations
managing   2-32

 

B

 

Background maps   1-20, 2-33
Bridging

controller software   1-22
enable

existing controller   2-41
new controller   2-12

 

C

 

Controller
activity   1-25
adding

group   2-12
network   1-33, 2-12

bridging status   1-30
collection status   1-27
comments   1-29
current state of operation   1-25
deleting   2-16
edit details   1-34, 2-41
information list   1-24, 1-32

IP address   1-25
software bridging   1-22
software release   1-30
status   1-24
user interface
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viewing details   2-41

Controller Details dialog   1-32
Controller List dialog
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Controller user interface

selecting   2-12
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description   1-1
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Group
adding to network configuration   2-7
annotations

managing   2-32
deleting   2-9, 2-11
description

GNE   1-8
hiding name   2-30

 

I

 

Icons
changing display size   2-29

 

L

 

Link continuation
arranging   2-24
description   1-15
displaying   2-23
GNE   1-15

Links
fiber, electrical, CNet   1-13, 2-19
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